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Chapter 1 Using This Guide 

This chapter introduces you to the caAdapter User’s Guide.  

Topics in this chapter include: 

• Intended Audience on this page 
• Recommended Reading on page 1 
• Document Text Conventions on page 1 
• Organization of this Guide on page 2 
• Library and Resources Files on page 2 

Intended Audience 
The caAdapter User's Guide is the companion documentation to caAdapter. This guide 
includes information and instructions for using caAdapter which consists of two components: 
a set of Application Programming Interfaces (APIs) and a mapping tool graphical user 
interface (GUI). See Chapter 1 for an overview of caAdapter. The technical audience (Java 
programmers, system architects, etc.) use this guide to utilize the major caAdapter 
Application Programming Interfaces (APIs) to parse, build and validate Health Level Seven 
(HL7) version 3 (v3) messages. Analysts (HL7 analysts, database administrators, business 
analysts, etc.) use this guide to follow the step-by-step procedures to create v3 xml 
message instances using the GUI, map and generate Study Data Tabulation Model (SDTM) 
text files, and map object and data models. 

This guide assumes that the reader is familiar with HL7, SDTM, object and data model terms 
and processes and only provides a brief overview of these concepts. Prerequisites for using 
the caAdapter Mapping Tool are also included. 

Recommended Reading 
Following is a list of recommended reading materials and resources which can be useful for 
familiarizing oneself with concepts contained within this guide.  

• HL7: http://www.hl7.org 

• National Cancer Institute Center for Biomedical Informatics and Information Technology 
(NCI CBIIT) HL7 Tutorial: 
http://trials.nci.nih.gov/projects/infrastructureProject/caAdapter/HL7_Tutorial 

• SDTM: http://www.cdisc.org/models/sds/v3.1/ 

• UML: http://www.uml.org/ 

Uniform Resource Locators (URLs) are also used throughout the document to provide more 
detail on a subject or product. 

Document Text Conventions 
The following table shows various typefaces to differentiate between regular text and menu 
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commands, keyboard keys, tool bar buttons, dialog box options, and text that you type. This 
illustrates how text conventions are represented in this manual: 

Convention Description 

Notes Notes: Notes are enclosed for emphasis 

Bold Bold type is used for emphasis, buttons, or tabs to select on windows, 
and names of dialog boxes. 

TEXT IN SMALL CAPS TEXT IN SMALL CAPS is used for keyboard keys that you press (for 
example, ALT+F4) 

Text in italics Italics are used to reference other documents, sections, figures, and 
tables. 

Special typestyle Special typestyle is used for filenames, directory names, commands, file 
listings, and anything that would appear in a Java program, such as 
methods, variables, and classes. 

Bold italics 
typestyle 

Bold italics is used for information the user needs to enter 

{ } Curly brackets are used for replaceable items (for example, replace 
{home directory} with its proper value such as C:\caadapter). 

Organization of this Guide 
The caAdapter User’s Guide contains the following chapters: 

• Chapter 1 Using This Guide - This chapter provides an introduction to this user’s guide. 

• Chapter 2 Overview of caAdapter  - This chapter provides an overview of caAdapter, 
caAdapter’s architecture, HL7, SDTM and object and data models. 

• Chapter 3 Using caAdapter  - This chapter provides operational scenarios for caAdapter 
using real-life examples. 

• Chapter 4 CSV to HL7 v3 Mapping and Transformation - This chapter provides detailed 
instructions for using the caAdapter Graphical User Interface (GUI) for CSV to HL7 v3 
mapping and transformation. 

• Chapter 5 HL7 v2 to HL7 v3 Conversion - This chapter provides detailed instructions for 
using the caAdapter GUI for HL7 v2 to HL7 v3 conversion. 

• Chapter 6 Regulatory Data Services Module – CSV to SDTM Mapping and 
Transformation - This chapter provides detailed instructions for using the caAdapter GUI 
for CSV to SDTM mapping and transformation, and database to SDTM mapping and 
transformation. 

• Chapter 7 Model Mapping - This chapter provides detailed instructions for using the 
caAdapter GUI for object model to data model mapping. 
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• Chapter 8 Using Functions in Mapping - This chapter provides detailed instructions for 
using and adding functions in caAdapter mappings. 

• Chapter 9 Using the caAdapter APIs - This chapter provides Java developers 
information required to use caAdapter APIs. 

• Chapter 10 Using the caAdapter Web Service - This chapter provides detailed 
instructions for using the caAdapter Web Service. 

• Chapter 11 caAdapter File Types - This chapter provides an overview of the different 
types of files used by caAdapter and an example of each. 

• Appendix A caAdapter Example Data - This appendix provides a description of the 
example data delivered with caAdapter. 

• Appendix B References - This appendix provides a list of references used to produce 
this guide or referred to within the text. 

Library and Resources Files 
caAdapter uses several library files. A few of those files are licensed by a third party, 
therefore, NCI CBIIT cannot include those with the caAdapter distribution files. We 
recommend for the user to obtain those files from their respective providers. Once obtained, 
the user must place those files under the “\caAdapter v4.0\lib” directory. The table below 
shows a list of those files with information on how to obtain each. 

Resource File 
Name 

Source Source URL Comments 

    

jgraph.jar JGraph www.jgraph.com  

resource.zip HL7 Organization www.hl7.org caAdapter can 
generate this file from 
the HL7 V3 Normative 
Edition 2006 CD 
available from the HL7 
Organization. Please 
reference the 
paragraph below for 
step-by-step 
instructions. 

resourceV2.zip – 
This file was 
manually 
constructed  

HL7 Organization www.hl7.org For details on obtaining 
this file, please contact 
the caAdapter support 
team at: 

NCICB Application 
Support 

http://ncicb.nci.nih.gov/
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NCICB/support 

Telephone: 301-451-
4384  

Toll free: 888-478-4423 

sqleonardo.jar SQLeonardo sqleonardo.altervista.
org 

 

 

Generating the resources.zip File 
1. Select Tools > Load HL7 v3 Normative Edition Processable Artifacts. 
2. The following screen will be displayed, select [Yes]. Note that the system will display this 

screen only if you already ran this process before at least once. 
 

 
3. Locate the HL7 Normative Edition home directory and click OK. 
 

 
caAdapter will begin processing the information to create the resource.zip file, and displays 
a confirmation message upon completion. 
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Chapter 2 Overview of caAdapter 

This chapter provides an overview of caAdapter, its architecture, and its related data standards.  

Topics in this chapter include: 

• caAdapter Overview on this page 
• caAdapter Core Engine Architecture on page 7 
• caAdapter Mapping Tool Architecture on page 8 
• HL7 Overview on page 8 
• SDTM Overview on page 10 
• Object and Data Model Overview on page 11 
• Prerequisites for Using the caAdapter Mapping Tool on page 11 
• caAdapter Installation on page 12 
• Starting the caAdapter Mapping Tool on page 12 

caAdapter Overview 
The caAdapter(http://ncicb.nci.nih.gov/NCICB/infrastructure/cacore_overview/caadapter)  
consists of several components that, via messaging standards, support data sharing at NCI 
CBIIT (http://ncicb.nci.nih.gov) and/or cancer centers as part of the cancer Biomedical 
Informatics Grid (caBIG) (http://caBIG.nci.nih.gov) solution. The components include a core 
engine for building, parsing, and validating HL7 v3 messages via an API or web service, and 
a mapping tool for providing mapping and transformation services using an assortment of 
messaging standards or formats such as HL7 v2 and v3, SDTM, and object and data 
models. 

The caAdapter core engine is an open source toolkit for building, parsing and validating HL7 
v3 messages from source clinical systems to promote data exchange in an international, 
standards-based messaging format. The core engine is a messaging framework that is 
based on an object-oriented data model, the HL7 RIM, and a set of v3 defined data types. 
This framework enables clinical applications to build and parse HL7 v3 messages based on 
specific schema definitions and perform structural, vocabulary and schema validation. 
caAdapter integrates with NCI CBIIT cancer Common Ontologic Representation 
Environment (caCORE) components (http://ncicb.nci.nih.gov/NCICB/infrastructure). See the 
caCORE Technical Guide (ftp://ftp1.nci.nih.gov/pub/cacore) and the caCORE Software 
Development Kit Programmer’s Guide (ftp://ftp1.nci.nih.gov/pub/cacore/SDK) for more 
information. This supports NCI CBIIT’s mission of developing a translational research 
infrastructure and building a clinical research network by providing a common platform for 
sharing data. 

The caAdapter Mapping Tool is an open source application that supports several types of 
mapping and transformation. It enables analysts and database engineers, who are 
knowledgeable about HL7, to create a mapping from Comma Separated Value (CSV) 
clinical data to an equivalent target HL7 v3 xml format. It provides a front end GUI and a 
back end engine to support specification of file formats, drag-and-drop mapping between 
source and target, validation of specifications and data, and transformation of actual CSV 
data into HL7 v3 xml message instances. 
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Using similar GUI and mapping features, the caAdapter Mapping Tool also enables HL7 v2 
analysts to convert v2 messages into CSV format for use with the CSV to HL7v3 mapping 
capabilities. In addition, the caAdapter Mapping Tool permits SDTM analysts to map CSV 
study data to the SDTM format. Core engine support for these processes will be added in a 
later release. 

Perhaps most useful to end users is the capability of the caAdapter Mapping Tool to support 
object to data model mapping. This component allows users to parse and load data and 
object models from an xmi file, map the object model to the data model using drag-and-drop 
capabilities, add SDK-required tags and tag values into the xmi file, and generate a 
Hibernate mapping file. 

caAdapter Core Engine Architecture 
Figure 2-1 illustrates the caAdapter core engine architecture design including its subsystems 
and components. 

 
Figure 2-1  caAdapter Core Engine Architecture 

The main features of the caAdapter core engine are: 

• Meta Data Loader - represents HL7 v3 metadata in-memory. 

• Message Parser – parses HL7 v3 messages to Reference Information Model (RIM) 
object graph. 

• Message Builder – builds HL7 v3 messages from the RIM object graph. 

• Validation Services 

• Message Service Integration (future plans) – integrates with message exchange 
services.  
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caAdapter Mapping Tool Architecture 
The caAdapter Mapping Tool is a graphical application for mapping clinical data to an HL7 
v3 message. Figure 2-2 illustrates the caAdapter Mapping Tool architecture design depicting 
its subsystems and components. 

 
Figure 2-2 caAdapter Mapping Tool Architecture 

 The mapping tool provides the following: 

• Source and Target Specification - graphical interface for defining input and output data 
formats. 

• User Interface - simple mechanism for mapping source fields to target elements 
containing tree structure, drag-and-drop functionality, and functions and property 
definitions. 

• Mapping Functions - capability to do simple source data manipulation. 

• Transformation Service - generation of HL7 v3 xml message instances and SDTM text 
files from a source database based on user-defined mapping specifications. 

• Validation - capability to validate the structure and content of HL7 v3 messages. 

HL7 Overview 
Health Level Seven (HL7) (http://www.hl7.org/) is one of several American National 
Standards Institute (ANSI)-accredited Standards Developing Organizations (SDOs) 
operating in the healthcare arena. HL7 provides standards for data exchange to allow 
interoperability between healthcare information systems. It focuses on the clinical and 
administrative data domains. The standards for these domains are built by consensus by 
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volunteers – providers, payers, vendors, government – who are members in the not-for-profit 
HL7 organization. 

HL7 version 2 (v2) is a messaging standard that focuses on syntactic data interchange. HL7 
messaging (v2 or higher) has been recommended as a data exchange standard by the e-
Government initiative. In fact, various releases of this version are in use in over 90% of U.S. 
hospitals, and v2 is considered the most widely implemented standard for healthcare 
information in the world. However, since it lacks an explicit methodology, conformance rules, 
and grouping of messages, it cannot be considered an interoperability standard. 

HL7 v2 messages are composed of segments (individual lines in a message) which are 
composed of fields (data values) which may in turn be composed of components and sub-
components. Several different delimiters or field separators are used to mark boundaries 
between the various elements. Specifications for messages using these structures are 
published in a text document format which does not easily lend itself to being computable. 
Furthermore, messages are often customized at local sites making it difficult to share 
messages between sites. caAdapter consequently includes a computable version of the 
message specifications which can be tailored to suit the needs of cancer centers and 
hospitals.  

HL7 as an organization aimed to address some of the problems of v2 in its next major 
version, version 3 (v3). The key goal of the HL7 community is syntactic and semantic 
interoperability. This goal is supported in HL7 v3 by what are commonly called the four 
pillars of semantic interoperability: 

1. A common Reference Information Model (RIM) spanning the entire clinical, 
administrative, and financial healthcare universe. The RIM is the cornerstone of the HL7 
v3 development process. An object model created as part of the v3 methodology, the 
RIM is a large pictorial representation of the clinical data domains and identifies the life 
cycle of events that a message or groups of related messages will carry. It is a shared 
model between all the domains and is the model from which all domains create their 
messages. Explicitly representing the connections that exist between the information 
carried in the fields of HL7 messages, the RIM is essential to HL7’s ongoing mission of 
increasing precision and reducing implementation costs. 

2. A well-defined and tool-supported process for deriving data exchange specifications 
from the RIM. HL7 has defined a methodology and process for developing 
specifications, artifacts to document the models and specifications, tools to generate the 
artifacts and an organization for governing the overall process of standards 
development. Such structure avoids ambiguity common to many existing standards. 

3. A formal and robust data type specification upon which to ground the RIM. Data types 
are the basic building blocks of attributes. They define the structural format of the data 
carried in the attribute and influence the set of allowable values an attribute may 
assume. HL7 defines an extensive set of complex data types which provide the structure 
and semantics needed to describe data in the healthcare arena. 

4. A formal methodology for binding concept-based terminologies to RIM attributes. Within 
HL7, a vocabulary domain is the set of all concepts that can be taken as valid values in 
an instance of a coded field or attribute. HL7 has defined vocabulary domains for some 
attributes to support use of the RIM in messages. It also provides the ability to use, 
document, and translate externally coded vocabularies in HL7 messages.  

 
The specifications that are developed upon this foundation are documented in a progressive 
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set of artifacts that represent varying levels of abstraction of the domain data. The artifacts 
go from purely abstract and universal in scope to implementation-specific and very narrow in 
subject matter: 

• The RIM is the foundational Unified Modeling Language (UML) class diagram 
representing the universe of all healthcare data that may be exchanged between 
systems. 

• A Domain Message Information Model (DMIM) is a subset of the RIM that includes RIM 
class clones, attributes, and associations that can be used to create messages for a 
particular domain (a particular area of interest in healthcare). DMIMs use HL7 modeling 
notation, terminology, and conventions. 

• A Refined Message Information Model (RMIM) is a subset of a DMIM that is used to 
express the information content for an individual message or set of messages with 
annotations and refinements that are message specific. 

• A Model Interchange Format (MIF) is an xml representation of the information contained 
in an HL7 specification, and is the format that all HL7 v3 specification authoring and 
manipulation tools will be expected to use.  

• A Message Type (MT) is the specification of an individual message in a specific 
implementation technology.  

The caAdapter APIs make use of the MIF and MT artifacts. While the HL7 standard is not 
implementation specific, caAdapter uses xml as its implementation technology.  

The NCI CBIIT provides training resources to assist the caBIG community and other 
interested parties in implementing HL7 v3 messaging. These resources include online 
tutorials, self-paced training, and links to HL7 resources 
(http://trials.nci.nih.gov/projects/infrastructureProject/caAdapter/HL7_Tutorial). 

SDTM Overview 
The Study Data Tabulation Model, or SDTM, is a set of standards developed by the Clinical 
Data Interchange Standards Consortium (CDISC). It provides structured guidelines for 
submitting study data tabulations to a regulatory authority such as the United States Food 
and Drug Administration (FDA). 

SDTM datasets are organized by “Domains” where each Domain contains a list of 
“Variables”. Each domain is identified by a two-letter acronym. An eight-character naming 
convention is used to refer to variables within a domain. An example domain is 
“Demographics” which is referred to by the acronym “DM”. The Demographics dataset 
contains variables such as patient name, patient date of birth, race, sex, and others. 

Domains are grouped into “Classes”. Domain classes include: 

• Trial Design 

• Interventions 

• Events 

• Findings, and, 

• Special Purpose 
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Figure 2-3 lists SDTM Domain Classes and associated Domains. 

 
Figure 2-3 SDTM Domain Classes 

SDTM dataset structures are fully defined in the guide “Study Data Tabulation Model 
Implementation Guide: Human Trials”, which is available from the CDISD website at 
(www.cdisc.org). Furthermore, SDTM datasets are defined in an xml document often 
referred to as the “define.xml”. This document allows submitters to define the structure of the 
dataset being submitted, especially the list of valid values used to validate certain variables. 
CDISC provides a sample “define.xml” document which was used in the implementation of 
the CSV to SDTM Mapping capability of caAdapter version 4.0. 

Object and Data Model Overview 
The caAdapter v4.0 Model Mapping Service takes advantage of the caAdapter mapping 
infrastructure to facilitate object to database mapping. The model mapping service requires 
an .xmi file (with full Enterprise Architect (EA) roundtrip capability) that includes a data 
model and an object model as input. It loads all models into the tool and then users can map 
an object element to a data model element using drag-and-drop capability. Once the 
mapping is done, caAdapter 4.0 adds all SDK-required tagged values into the xmi file and 
saves them to the .map file for backwards compatibility. After reimporting the newly tagged 
xmi file into EA and exporting an xmi 1.1 compatible xmi file, caCORE SDK can perform all 
code generation tasks.  

Prerequisites for Using the caAdapter Mapping Tool 
You must have the following prerequisites to successfully use the mapping tool: 

• Thorough familiarity with source data. 

• HL7 artifacts, messages, and data types for v2 and v3. 

• SDTM domains, variables, and “define.xml” document.  

• Object and data model. 
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• Training on the caAdapter Mapping Tool. 

• Familiarity with caAdapter Mapping Rules documentation. 

caAdapter Installation 
Complete instructions for installing caAdapter are located in the caAdapter Installation Guide 
at http://ncicb.nci.nih.gov/download/downloadhl7.jsp. 

Starting the caAdapter Mapping Tool 

Starting the Mapping Tool from the Binary Distribution 

Perform the following steps to launch the caAdapter Mapping Tool GUI. 

1. In a Command Prompt window, enter cd {home directory} to go to your home directory 
(for example, in Windows C:\caadapter). 

2. Enter java -jar caadapter_ui.jar. The “Welcome to the caAdapter” screen momentarily 
appears and the caAdapter Mapping Tool GUI displays. 

Starting the Mapping Tool from the Source Distribution 

Perform the following steps to launch the caAdapter Mapping Tool GUI. 

1. In a Command Prompt window, enter cd {home directory} to go to your caAdapter 
home directory (for example, in Windows C:\caadapter). 

2. Enter cd ..\hl7sdk and then enter ant all. 
3. Enter ant launchui. 
4. The “Welcome to the caAdapter” screen momentarily appears and the caAdapter 

Mapping Tool GUI displays.  

Starting the Mapping Tool from the Windows Distribution 

To launch the caAdapter Mapping Tool GUI, select caAdapter from the Start menu 
shortcut. 

Starting the Mapping Tool on the Web (WebStart) 

You can also use caAdapter via the web by entering the following: 
http://cbioga101.nci.nih.gov:49080/caadapter-mms/caadapter-mms.jnlp 

Note: This version of caAdapter on the web only supports the Model Mapping Services 
Module. Other modules will be added in future releases. 
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Chapter 3 Using caAdapter 

This chapter provides a high level overview for using caAdapter.  

Topics in this chapter include: 

• API Process Flow for CSV to HL7 v3 Transformation on this page 
• API Operational Scenario for CSV to HL7 v3 on page 15 
• Mapping Tool Operational Scenario for CSV to HL7 v3 on page 16 
• Mapping Tool Operational Scenario for HL7 v2 to HL7 v3 Transformation on page 16 
• Mapping Tool Operational Scenario for Regulatory Data Services Module on page 17 
• Mapping Tool Operational Scenario for Model Mapping Service on page 17 

API Process Flow for CSV to HL7 v3 Transformation 
This section describes the process for creating a validated HL7 v3 adverse event (AE) 
message, also known in HL7 as an ICSR, based on a given CSV file or set of files and a 
corresponding mapping specification. caAdapter uses the Transformation and Validation 
engine to perform different validation levels based on a user’s selection: structural only, 
structural and vocabulary; or structural, vocabulary and schema. 

The basic steps to accomplish this workflow using caAdapter are: 

• caAdapter receives a CSV file, its meta file, an HL7 v3 message specification, and the 
mapping file that the user used to map the CSV schema to the HL7 v3 message. 

• The transformation process uses the files above to create a preliminary HL7 v3 
message, an internal instance, which will be put through the validation process. 

• The validation process uses the internal instance of the message to perform the 
following validation sub-processes, (1) validation against the MIF specifications. (2) 
validation against HL7 v3 published vocabulary, and, (3) validation against the schema 
of that HL7 v3 message type. 

• caAdapter then creates the final HL7 v3 message that corresponds to the source CSV 
file. 

Figure 3.1 illustrates the transformation and validation processes. 
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Figure 3-1 Transformation and Validation Processes 

API Operational Scenario for CSV to HL7 v3 
A clinical trials coordinating center is automating the receipt and routing of AE reporting from 
the member hospitals and clinical centers. They have researched the options and chosen to 
implement HL7 v3 messaging. Their hospitals are implementing the messages and the 
coordinating center is preparing to handle the incoming messages. They have identified the 
caAdapter APIs as one part of their messaging infrastructure. 

When their messaging service receives an HL7 v3 message from a hospital or clinical 
center, it calls a caAdapter API to parse the incoming message. The parser validates the 
message against the appropriate xml schema description based on the message ID. It then 
builds an object graph in memory based on the schema definition and loads the data into the 
object graph. Another caAdapter API is called to validate the vocabulary used for the HL7 v3 
structural attributes using the NCI's EVS. This overall process builds a caAdapter log file 
that the system administrator can monitor. 

With the validated message content held in the object graph, the system can now perform 
the following: 

• Generate the HL7 v3 message for rerouting to the FDA using another caAdapter API for 
building messages. 

• Pass the caAdapter object graph in an API call to a separate persistence application 
where the data is stored for research/data mining and administrative purposes. 

• Notify the sending system that the message was received and processed using 
identifying data from the object graph. 
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Mapping Tool Operational Scenario for CSV to HL7 v3 
A research hospital has been faxing AE reports to a clinical trials coordinating center for 
submission to the Food and Drug Administration (FDA). Instead of using a manual effort to 
fill out the MedWatch 3500A form, they would like to automate and streamline the process. 
They have a clinical data management system (CDMS) where the necessary AE data is 
stored. They would like to automate the process by pulling data from this system and 
transforming it into an HL7 v3 message to route to the FDA. Their clinical systems analyst 
researched the HL7 standards and identified the correct specification to use, called the 
ICSR. The analyst uses the caAdapter Mapping Tool to implement this plan. 

The clinical systems analyst uses the caAdapter Mapping Tool to define a file specification 
that describes the source file for the transformation. This source specification outlines the 
format of a CSV file where each line is a segment containing a logical grouping of fields. 
Each segment may have one or more dependent child segments to handle one-to-many 
relationships between logical groups of data. The analyst also uses the caAdapter Mapping 
Tool and the HL7 ICSR's MIF file to generate a target file specification. This specification is 
based on the number and types of elements in the HL7 message that are needed to support 
their AE data. After source and target specifications are defined, the analyst then maps 
source fields to target fields using caAdapter's map specification tab. The application allows 
the analyst to drag-and-drop CSV source fields onto HL7 target fields and use functions to 
manipulate the data on the way. The result of this step is that a mapping specification is 
generated by the caAdapter Mapping Tool. After the mapping is complete, the analyst then 
uses the caAdapter Mapping Tool to test the generation of HL7 v3 ICSR xml message 
instances using a sample CSV file obtained from the CDMS.  

When this development process is complete, the caAdapter specification files and 
transformation APIs can be implemented as part of a message routing infrastructure to 
deliver AE data to the FDA in a streamlined fashion. 

Mapping Tool Operational Scenario for HL7 v2 to HL7 v3 
Transformation 

A number of research institutes have been submitting daily electronic AE data to a clinical 
trials coordinating center which in turn consolidates and submits to the FDA. The data is 
being submitted in HL7 v2.5 format. The coordination center anticipates a new FDA 
requirement which mandates that all AE submissions be in HL7 v3 format. The coordination 
center decides that the best way to meet this requirement is to add an HL7 v2.5 to v3 data 
conversion step to its current FDA submission process.  

Instead of manually implementing the conversion process, the coordinating center decided 
to use the caAdapter Mapping and Transformation tools to expedite the implementation. 

The clinical systems analyst researched the HL7 v3 standards and identified the best 
message type to use for submitting AE data. The next step is to map the data elements from 
the HL7 v3 v2.5 message currently being used, to the identified target HL7 v3 message. 

The first task of the conversion and transformation process is to use caAdapter to create a 
CSV file and CSV file specifications that match the HL7 v2.5 source message. The second 
step is to use the CSV to HL7 v3 mapping and transformation capability to map the CSV 
data elements to the target HL7 v3 message. For more information, see the previous 
sections in this chapter. Once the map file has been created, caAdapter will use that to 
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transform the data and create the HL7 v3 file. 

Mapping Tool Operational Scenario for Regulatory Data 
Services Module 

A research institute is planning the execution of a clinical trial and is in the process of 
reviewing reporting procedures to various regulatory entities. The results of the analysis 
showed that the Institute’s current CTMS can satisfy all electronic reporting requirements 
except for the reporting and submission to the FDA. The FDA has recently introduced the 
SDTM set of standards which all research centers must adhere to when submitting clinical 
trials data. The research institute can use caAdapter’s Regulatory Data Service (RDS) 
module to map its data, residing in CSV or relational database formats, to create the 
necessary SDTM datasets to help implement this new FDA requirement. 

In the case where the data resides in CSV formats, the clinical systems analyst can use 
caAdapter’s Mapping Tool to map the data elements from a CSV file to the corresponding 
SDTM domain data elements using drag-and-drop capability. Once the mapping is complete 
and a map file is created, the analyst can use the transformation service to transform the 
data from CSV format into SDTM dataset format. 

In the case where the data resides in a relational database, the clinical systems analyst can 
use caAdapter’s Mapping Tool to map a data element directly from the database to the 
proper SDTM domain(s).  The caAdapter Data Viewer will help the user create the 
necessary SQL queries necessary to extract the data from the databases to create the 
SDTM datasets. Using the Data Viewer capability is optional; caAdapter automatically 
creates the SQL statements needed once the user completes the mapping. 

Mapping Tool Operational Scenario for Model Mapping 
Service 

In order to generate silver-level compliant software, caCORE SDK developers must first 
develop an object model and a data model in EA. Second, the developers must manually 
add tag values to associate objects to tables, associate attributes to columns, and define 
various associations between objects. This approach is error prone and very time 
consuming. The caAdapter model mapping service component can greatly automate this 
process by automatically loading the object model and the database. The user can map 
objects/attributes to tables/columns using drag-and-drop capability. Next, caAdapter will 
automatically add tag values to the original xmi file and create an updated one. The user 
then can use the updated xmi file for caCORE SDK code generation.  

Users who are not using the caCORE SDK but want to map an object model to a database 
must develop a set of hibernate mapping files manually. The caAdapter model mapping 
service automates the Hibernate mapping file creation process in a similar fashion as 
described in the previous scenario. After developing the object model using EA, the user can 
import the corresponding data model. The user can then drag-and-drop objects/attributes to 
tables/columns and click the “generate hibernate hbm file” button to create the necessary 
set of hibernate mapping files. 
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Chapter 4 CSV To HL7 v3 Mapping and Transformation 

This chapter defines the step-by-step procedures to use the caAdapter Mapping Tool to perform 
CSV to HL7 v3 mapping and transformation.  

Topics in this chapter include: 

• caAdapter Mapping Tool Process Flow on this page  
• caAdapter Mapping Tool Common Features on page 19 
• Source Specification on page 23 
• Target Specification on page 28 
• Map Specification on page 44 
• HL7 v3 Message on page 56 
• Transforming an HL7 Message into a CSV Format on page 60 

caAdapter Mapping Tool Process Flow 
The basic steps to use the caAdapter mapping tool (Figure 4-1) are as follows: 

1. Generate a CSV specification file from CSV data. 
2. Generate an HL7 specification file from an HL7 MIF file. 
3. Load the source specification (CSV specification) on the left side and load the target 

specification (HL7 specification) on the right side in the mapping tool GUI. Define 
mappings by drawing lines between elements of the source and target sides and save 
the mapping to an xml file. 

4. Select the CSV data and the mapping file; the mapping engine will transform the data 
into an object instance based on the mapping file. caAdapter uses the object instance 
and builds the HL7 v3 message instance.  

 
Figure 4-1 How the mapping tool works 
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caAdapter Mapping Tool Common Features 

caAdapter Mapping Tool Interface 

The caAdapter Mapping Tool interface (Figure 4-2) is Windows-based and includes a main 
menu bar, a tool bar, and tabs located in the top of the window. The different panels can be 
resized by selecting the edge of the panel and dragging. Scroll bars are used when needed 
to display all the information. 

 
Figure 4-2 Mapping Tool interface 

The menu bar is context sensitive. Only the options that are available for your current 
window are displayed in black font; the other options are unavailable. For example, the 
Report option is unavailable in Figure 4-2 since it is not available for the .h3s file. 

The menu bar consists of the File, Report, and Help options. The File option allows you to 
perform the functions in Table 4-1. 
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File Options Description 

New Creates a new file for the type of file you select including: 
CSV to HL7 v3 Mapping and Transformation Service 
CSV Specification 
HL7 v3 Specification 
CSV to HL7 v3 Map Specification 
HL7 v3 Message 
HL7 V3 to CSV Transformation Service 
HL7 V3 To CSV 
 
HL7 v2 to HL7 v3 Mapping and Transformation Service  
HL7 V2 to SCS & CSV Conversion 
HL7 v3 Specification 
CSV to HL7 v3 Map Specification  
HL7 v3 Message 
RDS Mapping and Transformation Service 
CSV Specification 
CSV/Database to RDS Map Specification  
RDS Text File 
Model Mapping Service  
Object to Database Map Specification 

Open Opens an existing file for the type of file you select including: 
CSV Specification 
HL7 v3 Specification 
CSV to HL7 v3 Map Specification 
CSV to SDTM Map Specification 
Object to Database Map Specification 

Save (CTRL+S) Saves the file you are currently working on (in the selected tab). 

Save as Opens a ‘Save as’ dialog box to allow you to save the file to another file 
name. 

Validate Validates the file you are currently working on (in the selected tab). 

Close (CTRL+F4) Closes the file you are currently working on (in the selected tab). The 
following Data Changed dialog box appears if you have not saved your work, 
“Data has been changed but is not saved. Would you like to save your 
changes?” Select Yes, No or Cancel. 

Close all Closes all the files. 

Exit (ALT+F4) Exits the caAdapter Mapping Tool. 

Table 4-1 File menu options 
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The Report option currently allows you to generate reports for CSV and map specifications 
and for CSV to SDTM map specifications. The Help option contains information about 
caAdapter and online help Contents and Index options. 

The tool bar is context sensitive. Only the options that are available for your current window 
are displayed. Table 4-2 contains a list of available icons. There are shortcuts for the same 
functionality that can be accessed from the menu bar.  

Tool Bar Options Description 

 

Opens a new file of the type of file that is currently open. 

 

Saves the file that is currently open. 

 
Closes the tab that is currently open. 

 

Validates the file that is currently open. 

 

Refreshes the mapping panel. It is only visible if it is on the mapping 
panel. 

 

Opens the Help window. 

Table 4-2 Tool bar options 

The caAdapter Mapping Tool uses a document-oriented paradigm where up to four files of 
different types can be open at the same time, each within its own tab in a single window. 
The four different types of tabs are: 

1. CSV specification 
2. Map Specification (CSV to HL7 v2, CSV to SDTM, and Object to Database) 
3. HL7 v3 Specification (.h3s, xml) 
4. HL7 v3 Message / CSV data file 
 
In some cases, only one of each file type may be open at a time. If you open a new file of a 
file type that is restricted and already open, then the existing file will be replaced with the 
new file. The tab name displayed is the name of the file in the tab (for example, 
040011.h3s as shown in Figure 4-2) or it is labeled untitled.<ext>, where <ext> is 
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the appropriate file extension for that type of tab. The window layout changes depending on 
the type of tab displayed. For example, the HL7 v3 specification tab displays a tree structure 
in the left-hand panel and the properties and validation messages in the right-hand panel.  

caAdapter Mapping Tool Validation 

The caAdapter Mapping Tool contains validation on some of its tabs (further types of 
validation will be provided in later releases). Validation is used to: 

1. Validate the given specification to ensure it is technically correct before continuing onto 
the next step. 

2. Provide a user-friendly method to report errors so you can correct them. 
3. Provide reminder notes on the process (information messages). 

 
The results of the validation are displayed in the Validation Messages panel (Figure 4-3). 
Only one level of message is displayed at a time. From this panel you can: 

• Change the Message Level by selecting a different level from the drop-down list. 

• Click Save to save the messages to a file. 

• Click Print to send the messages to your printer. 

• Select a message to display the full content of the selected message in a panel below 
the Validation Messages panel (see Figure 4-3). 

 

Figure 4-3 Validation Messages panel 

Table 4-3 contains the different levels of messages produced during validation. 
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Message Level Description Example 

   FATAL The process leads the application into an 
unrecoverable situation where the 
application itself has to halt the process 
instead of moving forward. 

A file with a wrong file type is given 
to the map specification module and 
it does not know how to open the 
file. 

ERROR The process leads the application into a 
recoverable situation with serious issues 
that require your attention. It is better if 
these errors are resolved before 
proceeding or you could receive partial or 
incorrect results. 

The CSV data does not match a 
given specification. 

WARNING The process leads the application into a 
recoverable situation with medium level 
issues that won’t prevent the application 
from proceeding further. However, it may 
require your attention to resolve them so 
the process will generate the expected 
results. 

Not all segments and fields within 
the CSV specification have been 
mapped to the HL7 v3 specification. 

INFO Contains information, such as tips, 
suggestions, reminders, etc. You can 
simply ignore them if you want to. 

Contains the choice selected for an 
element 

Table 4-3 Validation messages 

Source Specification 

Segmented CSV Specification 

Business Rules 

Following are the business rules for a segmented CSV specification: 

• Two or more segments cannot have the same name. 

• Two or more fields cannot have the same name in same segment (case-insensitive). 

• Segment names must be a combination of any letters (A-Z) in CAPITALS, numbers or 
the underscore character. 

• Field names must be a combination of any letters (A-Z or a-z), numbers, or the 
underscore character. 

Step‐by‐Step Instructions 

This section contains the detailed instructions to use the Mapping Tool to create or update a 
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CSV specification. 

Overview of CSV Specification Tab 

The CSV Specification tab (Figure 4-4) allows you to identify the hierarchy of segments and 
fields that describe an incoming CSV data file that must be converted into one or more HL7 
v3 xml messages. The CSV specification tab separates the tree structure in the left-hand 
panel from the validation results and properties in the right-hand panel. The tree structure 
displays the hierarchy of segments and fields that represent the way data in the source CSV 
files are organized. Typical features of the tree structure are used, such as dragging and 
dropping an element to another location in the tree, or the ability to expand and collapse a 
branch of the tree using the + and - symbols respectively. The Properties section in the 
right-hand panel allows you to work with the metadata on the left. 

 

Figure 4-4 CSV Specification tab 

The following sections describe how to access, update, validate, and save the CSV 
specification. 

Creating and Opening a CSV Specification 

First, you must create a new or open an existing CSV specification. Select File > New > 
CSV to HL7 v3 Mapping and Transformation Service > CSV Specification to display the 
New CSV Specification dialog box. Select one of the following as the source to create a 
new CSV specification. 
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a. Blank CSV Schema - Click OK to open the CSV Specification file, named 
Untitled_1.scs, in a new tab with an empty tree except for an initial root 
segment which is named ROOT by default. 

b. Generate from a CSV Instance - Click Browse to display the Open CSV File 
dialog box. Select the appropriate .CSV file and click Open. The file is displayed in 
the New CSV Specification dialog box. Click OK to open the CSV data file in a 
new tab, named Untitled_1.scs, with the information from the data file 
displayed. 

c. New from an Existing CSV Specification File - Click Browse to display the Open 
CSV Specification dialog box. Select the appropriate .scs file and click Open. 
The file is displayed in the New CSV Specification dialog box. Click OK to open 
the CSV Specification file in a new tab, named Untitled_1.scs, with the 
information from the selected file displayed. 
 

Alternatively, open a CSV Specification file that was previously saved by selecting File > 
Open > CSV Specification to display the Open CSV Specification dialog box. Select the 
appropriate .scs file and click Open. A new tab opens with the CSV Specification file 
displayed in the tree. 

Updating the CSV Specification 

1. Once you have a CSV Specification file open, you can perform the following basic 
functions to update the tree hierarchy. Update any default field names to have 
meaningful names. 
a. Click on a segment in the tree structure to display the details of that element in the 

Segment Properties section (Figure 4-5). 

 

Figure 4-5 Segment properties 

b. Click the Move Up and Move Down buttons to re-arrange the sequence of the fields 
displayed under the given segment. By default the Move Up and Move Down 
buttons are both disabled unless you select any element in the field list (they are 
enabled in Figure 4-5 because id_extention is selected). Select a number/name row 
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and click the Move Up or Move Down button until you have the fields arranged 
correctly. Click Apply to update the tree structure. 

c. Edit the Segment Name and click Apply to update the tree in the left-hand panel. 

 Right-click on a segment to get the options available to perform on that segment 
(Figure 4-6). 
 

 

Figure 4-6 CSV segment right-click options 

d. Right-click and select Add Segment to display the Add Segment dialog box. Enter 
the CSV segment name and click OK. The segment is added to the tree structure.  

e. Right-click and select Add Field to display the Add Field dialog box. Enter the CSV 
field name and click OK. The field is added to the tree structure.  

f. Right-click and select Edit to display the Edit dialog box. Edit the CSV segment 
name and click OK. The segment name is changed in the tree structure.  

g. Select one or more segments, right-click and select Delete to display the 
Confirmation dialog box. Click Yes or No. The segment name(s) are deleted from 
the tree structure.  

2. Click on a field in the tree structure, to display the details of that element in the Field 
Properties section (Figure 4-7). 

 

Figure 4-7 Field Name metadata properties 

Edit the Field Name and click Apply to update the tree in the left-hand panel. 
3. Right-click on a field to get the options (Edit, Delete) available to perform on that 

field. 
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4. Right-click and select Edit to display the Edit dialog box. Edit the field name and 
click OK. The field name is changed in the tree structure.  

5. Select one or more fields, right-click and select Delete to display the Confirmation 
dialog box. Click Yes or No. The field name(s) are deleted from the tree structure.  

6. Drag-and-drop a field or segment to another area in the tree to rearrange the tree 
contents. Moving a segment takes its complete sub-tree with it. You may not drag-
and-drop the root segment; it must remain as the root, but its fields may be moved. 
The cursor indicates when the field or segment can be dropped. 

7. The Reset button can be used to reset changes made before selecting Apply. 
8. The Delete button can be used to delete an element from the tree.  

Validating the CSV Specification 

Once you are satisfied with the CSV specification, you can validate it by performing the 
following steps. 

1. Select File > Validate or select the Validate icon from the tool bar to display the 
Validate dialog box (Figure 4-8). 

 

Figure 4-8 CSV Validate options 

2. Select one of the following:  
a. To validate the specification, click Validate.  
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b. Or select Validate CSV Data Against Specification to test a CSV data file against 
the specification. Click Browse to display the Open CSV File dialog box. Select the 
appropriate .CSV file and click Open. Click Validate. 

3. The Dock validation results check box is automatically selected so that the messages 
are displayed in the right-hand panel, after the validation dialog is closed. The read-only 
validation messages are displayed. See caAdapter Mapping Tool Validation for more 
information on using the validation messages. 

Saving a CSV Specification 

When you are finished working on the CSV specification, select File > Save or File > Save 
As from the menu bar or click the save icon on the tool bar to create an xml-like file 
describing the tree structure. This file is portable and can be opened by the same or another 
user later. 

Generating a Report 

When the CSV Specification tab is selected, you can export the CSV specification into an 
Excel spreadsheet by performing the following steps. 

1. Select Report > Generate Report from the menu bar to display the Select File to Save 
Generated Report dialog box. 

2. Enter a file name and click Save. A “Report has been successfully generated” message 
displays. 
 
A part of a generated CSV report is shown in Figure 4-9. 

 

Figure 4-9 Part of a generated CSV report 

Target Specification 

HL7 v3 Specification 

Business Rules 

Following are the business rules for the HL7 v3 specification: 

• Abstract data types must be specialized. 
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• A choice must be selected on choice options. 

• If an element’s cardinality is one then it must have either a default value or a mapping. 

• If an element’s cardinality is greater than one then you have a choice to add multiple 
fields. 

• Only mandatory clones are included when a new HL7 v3 specification is first created. 
Optional clones may be added. 

• nullFlavor filed is optional. 

• Address data types are only enabled with a pre-defined subset of its data fields. All other 
data fields can be optionally added or removed. 

Step‐by‐Step Instructions 

This section contains the detailed instructions on how to use the mapping tool to create or 
update an HL7 v3 specification. 

Overview of HL7 v3 Specification Tab 

The HL7 v3 specification tab (Figure 4-10) allows you to identify the hierarchy of elements 
needed for your data based on what is available in the predefined structure of an HL7 v3 
message type. You update the basic specification to reflect your specific requirements, such 
as adding multiples of fields with a cardinality of greater than one, including or excluding 
clones, defining concrete data types for abstract ones or selecting choice options. 
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Figure 4-10 HL7 v3 Specification tab 

The HL7 v3 specification tab separates the tree structure in the left-hand panel from the 
properties and validation messages in the right-hand panel. The tree structure displays the 
hierarchy of elements that represent the way data in the .h3s files are organized. The 
elements are designated as follows: 

• C - Clone 

• A - Attribute 

• D - Data Type 

Typical features of the tree structure are used, such as the ability to expand and collapse a 
branch of the tree using the + and - symbols respectively. The properties panel allows you to 
update some information such as the user-defined default value for a given data type field or 
to select a concrete data type for a given Attribute. Right-click on an element to display the 
actions available as shown in the submenu in Figure 4-11. The available options are regular 
font.  
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Figure 4-11 Options for HL7 v3 elements 

The following sections describe how to create, update, validate, and save the HL7 v3 
specification.  

Creating and Opening an HL7 v3 Specification  

You must either create a new or open an existing HL7 v3 specification. The following steps 
describe how to create a new HL7 v3 specification. 

1. Select File > New > CSV to HL7 v3 Mapping and Transformation Service > HL7 v3 
Specification to display the HL7 v3 Specification dialog box with valid message types. 

2. Select the appropriate HL7 message category and message type from the drop-down 
lists (Figure 4-12) and click OK. 
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Figure 4-12 Example HL7 v3 message types 

Currently, the mapping tool supports all message types as defined by HL7 standards 

3. A new HL7 v3 specification tab displays with the name untitled_1.h3s.  
 
To open an existing HL7 v3 specification, select File > Open > HL7 v3 Specification (.h3s) 
or File>Open >HL7 V3 Specification (.xml) to display the Open HL7 v3 Specification 
(H3S) File dialog box. Select a File name to open and click OK. The HL7 v3 specification 
displays in a tab with the name of the file and its extension. 

Defining inline Text 

The data type field named inline Text is caAdapter's way of referring to text that appears 
between xml tags as opposed to being a value assigned to an xml attribute. The names of 
data types designed with inline Text fields are configured within the caadapter.properties file 
under the item: caadapter.hl7.attribute.inlinetext.required. The data types of address parts 
and name parts are assigned as system default. Any other data type may be added in. For 
example, in the following xml, "Rockville" is the inlineText: <city>Rockville</city>. But in the 
following xml, "WP" is the value for an xml attribute: <addr use="WP">. Enter the required 
text for such an attribute in the User-defined Default Value field.  

Defining Units of Measure  

Some HL7 v3 data types contain units of measure properties. These units of measure must 
match those specified in the Unified Code for Units of Measure (UCUM). The UCUM is a 
code system intended to include all units of measure being contemporarily used in 
international science, engineering, and business. For a complete list, see 
http://aurora.regenstrief.org/UCUM/ucum.html. 

Defining Default Data 

User-defined default values are pre-defined constants for data type field values. These 
defaults allow you to assign values for data type fields that may not be available from the 
source data. For example, if the root for all user ids is common across the organization, this 
value can be entered in the target specification. HL7 structural attributes and other elements 
that have their values fixed by the HL7 v3 standard cannot have user-defined default values. 

User-defined default values are overridden by values mapped from a data source. While 
required attributes should always be populated with either an HL7-defined or user-defined 
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default value, optional ones are only populated when a map is present for that data type. 
Table 4-4 shows the expected behavior for attributes that are mapped with a CSV value, 
mapped with a null CSV value and unmapped data types. 

 Mapped to Non-Null 
Field 

Mapped to  
Null Field UnMapped 

Optional CSV Value Default Value Element not created unless 
other sibling fields are mapped 

Optional(Force xml) CSV Value Default Value Default Value 

Required CSV Value Default Value Default Value 

Mandatory CSV Value Default Value Default Value 

Table 4-4 Default value behavior 

“Optional” means that the element is optional in the target message. It is not required if it 
has not been mapped.  

“Optional (Force xml)” means that the element is optional in the HL7 MIF specification, but it 
is required by the user to create an empty element with a default value.  

“Mandatory” means that the value may not be NULL, unless its container (clone, attribute, 
etc.) is NULL. Required means values must be supported but they may be NULL. 

Defining Object Identifiers (OIDs) 

HL7 v3 artifacts use OIDs to identify coding schemes and identifier namespaces. A full list of 
HL7 assigned OIDs, and the details of the registered schemes, is available from the OID 
Registry page of the www.hl7.org web site (Members Only section). There are two types of 
OIDs that can be used within an HL7 message: 

1. HL7 OIDs 
2. Existing OIDs 

 
In HL7, OIDs are assigned within the appropriate branch of the HL7 OID root 
(2.16.840.1.113883). If you are interested in assigning an OID to a scheme, be sure to 
check that the scheme you are assigning does not already have an OID assigned to it within 
the HL7 OID hierarchy. The process of registering an existing OID with HL7 involves adding 
an OID and its descriptive data to a central registry. The OID does not have to be within the 
HL7 root OID or any other specific root or branch OID. Once a scheme has been registered, 
no other OIDs that identify the same scheme can be registered. 

 Examples of OIDs used in HL7 are: 

• Coding schemes created by professional bodies that are intended to be used widely. For 
example, Systematized Nomenclature of Medicine (SNOMED), Logical Observation 
Identifiers, Names and Codes (LOINC), International Classification of Diseases (ICD), 
etc. need to be registered by HL7 International. 

• Civil namespaces. Identification schemes such as driver’s license, social security 
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numbers need to be registered by the appropriate HL7 Affiliate. 

• In the HL7 v3 specification, when you have a codeSystem data type field, you must 
assign the OID in the User-defined Default Value field (Figure 4-13) or you must have 
a map. 

 

Figure 4-13 OID entered in the User-defined Default Value field 

Adding Clones to the HL7 v3 Specification 

The ability to add or remove a clone is the way the caAdapter Mapping Tool accommodates 
optional associations in an HL7 message. Due to the size and complexity of numerous 
associations, nodes are initially created in the tree for mandatory associations only. You 
must customize the HL7 v3 specification to include the associations that are needed for your 
particular mapping plans by using the Add Clone and Remove Clone options.  

Perform the following steps to add associations or expand one recursive child generation at 
a time. 

1. Right-click on an element name with an optional or recursive relationship and select Add 
Clone to display the Clone List dialog box (Figure 4-14). 
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Figure 4-14 Clone List dialog box 

2. In the Clone List dialog box, select one or more of the unused clones and click OK. The 
corresponding nodes are added to the tree in the left-hand panel. 

3. There may be further optional associations available on the new clones just added. This 
is the case with a recursive association, where you could continue adding recursive 
levels to an arbitrary level as needed by using Add Clone. 

Perform the following steps to remove clones. 

1. Right-click on an element name with an optional or recursive relationship to its parent 
and select Remove Clone to display the Clone List dialog box. 

2. In the Clone List dialog box, select one or more of the unused clones and click OK. The 
corresponding nodes are deleted from the tree in the left-hand panel. 

Adding and Deleting Multiples to the HL7 v3 Specification 

Message elements that have either a cardinality of 0..* or 1..* and/or a data type that 
involves a collection (for example, SET, BAG, LIST) contain the [Multiple] label. The 
[Multiple] label is displayed as a numbered label to indicate the number of elements defined 
for that multiple (for example, [1], [2], etc.). These items appear in the HL7 v3 specification 
as simple repeats of the element. To accommodate the possible requirement of mapping 
more than one source element to the same target element, you must add multiples of these 
elements. 

Perform the following steps to add multiple clones. 

1. Right-click on a clone that contains a [Multiple] label (or a [1] label, which is the first of 
this group of multiple clones) and select Add Multiple Clone (Figure 4-15). 
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Figure 4-15 HL7 v3 specification multiple clones 

1. Another element is created and the label is changed to the number of elements created. 
 

Perform the following steps to remove multiple clones. 

1. Right-click on a clone with the [xx] label (where xx is a number greater than one), 
indicating that it is a replicated clone, the Remove Multiple Clone is enabled, select 
Remove Multiple Clone. See Figure 4-15 HL7 v3 specification multiple clones. 

2. One multiple of the element is removed from the tree structure. 
 
Perform the following steps to add multiple attributes. 

1. Right-click on an attribute with the [1] label, indicating that it is a replicated attribute, the 
Remove Multiple Attribute is enabled, select Remove Multiple Attribute (Figure 
4-16). 
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Figure 4-16 HL7 v3 specification multiple attributes 

2. Another element is created and the label is changed to the number of elements created. 
 
Perform the following steps to remove multiple attributes. 

1. Right-click on an attribute with the [1] label, indicating that it contains multiple numbered 
labels, and select Remove Multiple Attribute. 

2. One multiple of the attribute is removed from the tree structure. 
 
If a clone contains one or more child choice associations, it is always enabled with 
“Adding and Deleting multiple clone” without influencing its cardinality. This feature is 
implemented to support more than the possible chosen item for the child choice 
associations. Figure 4-17 and Figure 4-18 show that the patient is a clone with a 
cardinality of 1..1, but is enabled with “Add Multiple Clone” and “Remove Multiple Clone” 
actions. 
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Figure 4-17 Clone with one or More Child (Patient 1) 

 

Figure 4-18 Clone with one or More Child (Patient 2) 
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Updating Abstract Data Types in the HL7 v3 Specification 

Abstract data types occur when HL7 message developers do not specify a particular data 
type to use when populating attributes and are indicated by a [QTY] or [ANY] label in an 
HL7 v3 specification. You must assign a specialized data type to the abstract element by 
performing the following steps. 

1. Select the element name in the left-hand panel to display its properties in the HL7 v3 
Specification Properties panel. 

2. Use the drop-down list in the Data Type field (Figure 4-19) to select the data type. Click 
Apply. 

 

Figure 4-19 Data Type drop-down list 

3. After assigning a concrete data type with an abstract data type, the system will retrieve 
the data fields of the assigned data type and attach those to the original attributes 
accordingly. Repeat steps 1 and 2 above if you need to change a different concrete data 
type. 

Using Choice Boxes in the HL7 v3 Specification 

HL7 choice boxes pose a challenge in the representation of options in a mapping tool. 
Currently, the caAdapter Mapping Tool's implementation limitation for choice boxes is the 
ability to choose only a single option to which all logical records in the source file may be 
mapped. The presence of a choice is indicated with a [Selected Choice] or [Choice 
Unselected] label.  
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Perform the following steps to make a choice selection for an element. 

1. Right-click on an element name that contains a [Choice - Unselected] label and select 
Select Choice to display the Clone List dialog box. 

2. Select one and only one clone from the displayed list and click OK. This creates an 
expandable node with the [Selected Choice for] label displayed beside the parent clone 
node (Figure 4-20). 

 

Figure 4-20 Selected choice 

Note: Since a business rule for an HL7 v3 specification specifies a choice must be selected, 
there is no option to unselect a choice. However, if the parent association is optional, the 
association can be dropped and re-added. 

Enabling and Disabling Force xml with an Optional Clone 

If a clone is optional for the target message specification, right click the tree node to make 
Enable Force xml active (Figure 4-21). 

If a clone is optional for the target message specification, and it has been enabled, right click 
the tree node to enable Disable Force xml. Enable Force xml or Disable Force xml will 
inform the HL7 message transformation engine whether or not to create an empty element if 
no mapping has been set (Figure 4-22). 
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Figure 4-21 Enable Force xml 

 

Figure 4-22 Disable Force xml 
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Adding and Removing Parts of an Address Data Type 

If the system has predefined a subset of data fields for an attribute with an Address data 
type, other data fields can be added or removed (Figure 4-23 and Figure 4-24). 

 

Figure 4-23 Adding or removing parts of address data type 

   

Figure 4-24 Modifying an Address Data Type 
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Validating the HL7 v3 Specification 

You can validate a portion of or the entire HL7 v3 specification. A clone must be selected to 
perform the validation. The validation is performed on the selected clone and any children 
and further descendants below it in the tree structure. 

Perform the following steps. 

1. Select File > Validate, select the Validate icon from the tool bar or right click a clone 
and select Validate to perform the validation. 

2. A Message dialog box displays (Figure 4-25) indicating the status of the validation. Click 
OK. 

 

Figure 4-25 HL7 v3 specification validation 

3. The messages display in the Validation Messages panel (caAdapter Mapping Tool 
Validation). 

Saving an HL7 v3 Specification 

When you are finished working on the HL7 v3 specification, select File > Save or File > 
Save As from the menu bar, or click the save icon on the tool bar. If the specification is 
being saved for the first time, the system prompts to select either an .h3s or .xml format 
(Figure 4-26). To change the format after it has been selected the first time, select Save As. 
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The file is portable and can be opened by the same or another user later. 

 

Figure 4-26 Saving HL7 Specifications 

Map Specification 
A map is a user-defined, direct relationship between two pieces of specification elements. 
Using the mapping tool, you create links between source fields and target data type fields 
and between source segments and target clones or attributes. Links between source fields 
and target data type fields are used to represent data relationships. Links between 
segments and clones or attributes are used to explicitly link concepts that provide a context 
to the data and are also called container mappings. Links may also be created between 
source fields and input parameters of a variety of functions provided by caAdapter, and 
between the function's output parameters and target elements. 

Business Rules 

Following are the business rules for a map specification: 

• It must contain a valid mapping pair (source and target files). 

• The source element referenced in the map specification must exist in the source 
specification. 

• The destination element referenced in the map specification must exist in the destination 
specification. 

• A mandatory MIF element must have either a mapping in the map specification or an 
HL7-defined or user-defined default value in the HL7 v3 specification. 

• Each input parameter for a function must have a mapping or a constant defined. 

• Each output parameter for a function must have a mapping. 
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Step‐by‐Step Instructions 

This section contains the step-by-step instructions to create the mappings. See Appendix A on 
page 153 for detailed information on mapping scenario 8 included with the example data. 

Overview of the Map Specification Tab 

The map specification tab allows you to assign fields in a source specification to elements in a 
target specification. For the source (the CSV specification) and the target (HL7 v3 specification), 
the hierarchy is visually represented using an expandable/collapsible tree structure. The target 
specification can either be .h3s or .xml format. 

The map specification tab (Figure 4-27) consists of the following: 

• Two tree panels - contain the source specification in the left-hand panel and the target 
specification in the right-hand panel. 

• Center mapping panel - displays the lines that indicate the mapping between source 
and target elements and any functions that are used in the mappings. 

• Functions panel - displays a tree of available functions. 

• Properties panel - changes depending on the item selected in the other panels (for 
example, displays link properties, HL7 v3 specification data type field properties, CSV 
field properties, etc.) 

 

Figure 4-27 Map Specification tab 
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The tree structures are read-only; you must make any changes to the tree structures in the 
source or target specification tabs. You can only define the mappings from this tab. 

Warning! Adding to source or target specifications that are referenced in a map file is 
allowable, but editing or removing source or target elements may result in a related mapping 
(link) getting dropped or producing other unpredictable behavior. 

The following sections describe how to access, create, and save the map specification. 

Creating and Opening a Map Specification  

You must create a new or open an existing map specification.  

Perform the following steps to create a new map specification. 

1. Select File > New > CSV to HL7 v3 Mapping and Transformation > Map 
Specification from the menu bar to open a new mapping tab with empty source and 
destination panels. 

2. Click Open Source to display the Open Source File dialog box. 
3. Select the source file and click Open to populate the source panel with its tree structure.  
4. Click Open Target to display the Open Target File dialog box. 
5. Select the target file (.h3s or .xml format) and click Open to populate the target panel 

with its tree structure.  
 
Perform the following steps to open an existing map specification. 

1. Select File > Open > CSV to HL7 v3 Map Specification. The Open Map File dialog box 
displays. 

2. Select the map specification file and click Open to display the source and target trees 
along with any existing mappings.  

Updating the Map Specification 

Perform the following steps to create a mapping. 

1. Select a source element and drag it to the appropriate target element. The cursor 
indicates if the source is not allowed to be mapped to the target element (Figure 4-28 
and Figure 4-29). 
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Figure 4-28 Mapping is not allowed 

The cursor indicates when the source can be mapped to the target element. Drop the source 
on the target element. 

 

Figure 4-29 Mapping is allowed 

2. Once a source field is mapped to a target element, a mapping line appears between 
them in the mapping panel. Figure 4-30 shows a mapping line between id_root and 
root. 
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. 

Figure 4-30 Mapping line between a source field and target element 

To delete a mapped line or a function in the center panel, perform the following steps. 

1. Select the item you want to delete, right-click and select Delete.  
2. Click Yes to confirm the deletion. The selected item is deleted from the mapping. 

The Properties panel displays information on the selected element. When you select a 
source element, the CSV Field Properties displays (Figure 4-31). 
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Figure 4-31 CSV Field Properties panel 

When you select a mapping line, the Link Properties displays (Figure 4-32). 
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Figure 4-32 Link Properties panel 

When you select a target element, the HL7 v3 Specification Attribute Properties, HL7 v3 
Specification Data Type Field Properties or the Clone Attribute Object Properties 
displays (Figure 4-33). 
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Figure 4-33 Attribute properties 

When you select a function either in the Mapping panel or in the Functions panel, the 
Function Properties display. When you select a function group in the Functions panel, the 
Function Group Properties display (Figure 4-34). 
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Figure 4-34 Function Group Properties 

Using Functions in Map Specifications 

The Functions panel (Figure 4-35) provides a list of system defined functions that facilitate 
the data transformation requirement. Functions are grouped by functional categories (for 
example, constant, date, math, string, etc.). You may use a function in the mapping to effect 
a change of the source element to the target element. For example, you can use the 
concatenate function to add a prefix to an element.  

Note: You can add your own required functions to the function library. See Adding Functions 
to the Function Library on page 114 for instructions. 

When a function is selected in the function library, its properties information displays, such 
as name and number of input and output parameters, in the Function Properties panel 
(Figure 4-35).  
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Figure 4-35 Functions in mapping specification 

Perform the following steps to include a function in your mapping specification. 

1. Add a function to the mapping panel. Select a function in the Functions panel, right-click 
in the center panel and select Add Function, or drag-and-drop the required function 
from the Functions panel to the mapping panel. Move this function box around the 
mapping panel as convenient to attach the mapping lines. 

2. Drag-and-drop the source field(s) onto the input parameters. Figure 4-36 shows the 
selected field text being dropped as an input to the Initcap function. 

 

Figure 4-36  Adding an input to a function 
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3. Drag-and-drop the target field onto the output parameter. The mapping lines go from the 
source fields into the function box and out of the function box to the target fields. 

Editing a Constant Function 

Perform the following steps to edit a constant function. 

1. Select a constant function in the mapping panel, right-click and select Edit Constant. 
2. In the Edit Constant dialog box, change the Type and/or Value for the constant and 

click OK. 

Using the Date Function 

The date function, changeFormat, uses the Java SimpleDateFormat class. See 
http://java.sun.com/j2se/1.5.0/docs/api/java/text/SimpleDateFormat.html for more 
information. Table 4-5 show the correct syntax for each date or time component. 

Date or Time 
Component Presentation Example Pattern 1 Example Pattern 2 

Year Lowercase y yy => 05 yyyy => 2005 

Month Uppercase M MM => 07 MMM => JUL 

Day Lowercase d dd => 07 or 17 (7th or 
17th date of the 
month) 

d => 7 or 17 

Hour Uppercase H or 
lowercase h 

Using 2 PM  
HH => 14 

 hh => 02, h => 2 

Minute Lowercase m mm => 09 m => 9 

Second Lowercase s ss => 12   

Millisecond Uppercase S SSS => 002  

Table 4-5 Date formats 

For example, July 7th 1988, PM 02:23:14 can be presented in the following ways: 

• yyyyMMddHHmmss => 19880707142314 

• dd-MMM-yyyy, HH:mm:ss => 07-JUL-1988, 14:23:14 

• MM/dd/yy => 07/07/88  

Refreshing the Map Specification Tab 

Click the Refresh button on the tool bar to check and update the associated CSV specification or 
HL7 v3 specification used in the mapping panel. If changes to the mapping panel were required, 
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an information message (Figure 4-37) displays. 

 

Figure 4-37 Mapping panel refreshed message 

This option allows you to update and save the associated CSV or H3S file in their own tabs, 
while you are also performing the mapping between the two. 

If either the CSV or H3S files are updated and saved in their own tabs, and you switch back 
to the mapping panel, then a dialog (Figure 4-38) displays to notify you of the changes. You 
are not forced to refresh the mapping panel at this time, since you may have some pending 
mapping activity unsaved. 

 

Figure 4-38 Refresh mapping panel recommendation 

Validating the Map Specification 

Perform the following steps to validate the map specification. 

1. Select File > Validate or select the Validate icon from the tool bar to perform the 
validation. 

2. A Message dialog box displays indicating the status of the validation. Click OK. 
3. The detailed messages display in the Validation Messages dialog box (caAdapter 

Mapping Tool Validation). 

Saving a Map Specification 

When you are finished working on the map specification, select File > Save or File > Save 
As from the menu bar or click the save icon on the tool bar to save the file. This file is 
portable and can be opened by the same or another user later. 

Warning! The map specification has an internal reference to the full path name of the source 
and target specification files and those must be accurate to process the conversion or edit a 
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map specification successfully. If you are sharing map specification files with other users, 
you must send all three files, the CSV specification (.scs), HL7 v3 specification (.h3s), and 
map specification (.map); not just the map specification. Furthermore, the CSV and HL7 v3 
specification files must be in the same path locations as they were on the machine where 
they were created. Alternatively, the path name can be manually removed by editing the 
.map file however this is dangerous and unpredictable results may occur if the file is 
changed improperly. 

Generating a Map Specification Report 

When a map specification tab is selected, you can generate a report on the status of the 
mapping specification by performing the following steps. 

1. Select Report > Generate Report from the menu bar to display the Select File to Save 
Generated Report dialog box. 

2. Enter a File name and click Save. A “Report has been successfully generated” message 
displays. 
 
The report is an Excel spreadsheet containing the status of the mapping specification. The 
report contains up to six worksheets (tabs) within the generated report. Under the mapped 
category, it contains the mapping status between: 
• Source and target - Mapped(Source_Target) 

• Source and function - Mapped(Source_Function) 

• Function and target - Mapped(Function_Target) 

• Function and function - Mapped(Function_Function) 

Under the unmapped category, it contains the unmapped elements: 
• Source - Unmapped_Source 

• Target - Unmapped_Target 

HL7 v3 Message 
Generating the HL7 v3 message is the end goal in using the mapping tool. xml HL7 
message instances are created using the map specification and a corresponding CSV data 
file. 

Business Rules 

Following are the business rules for creating an HL7 v3 message: 

• You must have data in a CSV format. 

• The map specification must be valid. 

• The source and target specifications used to create the map must be located in the 
same directory as they were when the map specification was created (or the map 
specification must have been edited to point to the new location of these files if they 
were moved). The map specification uses the references to these files as it converts the 
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data into the new format. 

Step‐by‐Step Instructions 

This section contains the step-by-step instructions to generate the HL7 v3 message. 

Note: There is no File > Open option that corresponds to HL7 v3 messages since you 
always want to generate fresh messages based on the current selection of source and map 
files. 

Overview of the HL7 v3 Message Tab 

The purpose of the HL7 v3 Message tab is to allow you to generate and view the xml instances 
and messages converted from a data file and map specification. Each data file may have one or 
more logical records which result in a corresponding number of xml instances (or more 
depending on the structure of the mapping). The user interface allows you to navigate between 
the instances. The HL7 v3 message tab (Figure 4-39) contains the following four panels: 

• Regenerate and navigation buttons 

• Name of data file and map specification used 

• Scrollable text fields for xml instances 

• Scrollable text fields for validation messages 

 

Figure 4-39 HL7 v3 Message tab 
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Starting the Conversion Process 

Perform the following steps to convert a data file into an HL7 v3 message. 

1. Select File > New > CSV to HL7 v3 Mapping and Transformation > HL7 v3 Message 
from the menu bar to display the HL7 v3 Message dialog box (Figure 4-40). 

 

Figure 4-40 HL7 v3 Message dialog box 

2. Click Browse next to Data File to display the Open Data File dialog box. 
3. Select the data file you want to use in the conversion process and click Open. 
4. Click Browse next to Map Specification to display the Open Map Specification dialog 

box. 
5. Select the map specification file you want to use in the conversion process and click 

Open. 
6. Click OK to generate HL7 v3 messages from the selected files. 
7. Given the underlying data and mapping structure, it could take a long time to complete 

the HL7 v3 message generation task. If the system estimates that it will take longer than 
ten seconds (as is defined and configurable in the source distribution), then the 
Question dialog displays as shown in Figure 4-41. Click Yes to start the process or click 
No to abort the process given the estimated time. 

 

Figure 4-41 HL7 v3 message generation confirmation 

8. After a Yes confirmation, the process starts and a progress dialog box displays (Figure 
4-42). The system monitors the transformation progress for both loading the data, which 
includes reading the map file, source and target data specification; and the count of 
messages generated. 
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Figure 4-42 HL7 v3 message generation progress dialog 

9. Once the process starts, you can cancel the process by clicking Cancel. If cancelled, the 
underlying generation process is terminated and an information dialog displays (Figure 
4-43). 

  
Figure 4-43 HL7 v3 message generation cancelled 

10. A message displays (Figure 4-44) after the overall process completes. Click OK. 

 

Figure 4-44 HL7 v3 message process complete 

11. The HL7 v3 Message tab displays. 

Using the Basic Features of the HL7 v3 Messages Tab 

The two main features of the HL7 v3 Message tab (Figure 4-45) are the two scrollable text fields 
containing an xml instance and the associated error, warning and/or informational messages 
generated during the conversion process. 
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Figure 4-45 HL7 v3 Message tab 

Click the Previous and Next buttons to cycle through the xml messages one at a time. As the 
messages change, the validation messages change. See caAdapter Mapping Tool Validation on 
page 22 for more information on the validation messages. Click the Regenerate button to 
regenerate the messages from scratch using the same data file and map specification. 

Saving an HL7 v3 Message 

Select File > Save or File > Save As from the menu bar or click the save icon on the tool 
bar to save the HL7 v3 message. If there is more than one instance of a message, then the 
files are saved with number extensions (for example, example_message_1.xml, 
example_message_2.xml, example_message_3.xml).  

Note: Validation messages are not saved with their corresponding xml message and must 
be saved separately using the Save button in the Validation Messages panel. 

Transforming an HL7 Message into a CSV Format 
This version of caAdapter provides the capability to map and transform an HL7 messages 
into a CSV structured files. This capability addresses such requirement where HL7 v3 data 
must be persisted into a system already capable to of persisting data from CSV files.  

Business Rules 

The business rules are similar to those that apply to transforming CSV data into HL7 v3 
messages with the source and target reversed, i.e. transforming HL7 V3 into CSV 
structure/file. 
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Step‐by‐Step Instructions 

This section contains the step-by-step instructions to generate a CSV dataset from an HL7 
V3 message. 

Note: There is no File > Open option that corresponds to CSV data file since you always 
need to generate fresh CSV data based on the current selection of the source HL7 V3 
message, and the map files. 

Reuse of the HL7 v3 Message Tab 

The purpose for reusing the HL7 V3 Message tab is to generate and view the CSV data 
generated from the HL7 V3 message data. Each data file may have one or more logical records 
which result in a corresponding number of CSV meta instances (or more depending on the 
structure of the mapping). The user interface allows navigating between the various instances. 
The reused HL7 v3 message tab (Figure 4-39) contains four panels: 

 

Figure 4-46 Displaying CSV Data with HL7 v3 Message Tab 

Starting the Conversion Process 

Use the following steps to convert an HL7 v3 message into a CSV data file. 

1. Select File > New > HL7 V3 To CSV Transformation Service> New HL7 V3 To CSV 
from the menu bar to display the HL7 V3 To CSV dialog box (Figure 4-47). 
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Figure 4-47 HL7 V3 to CSV Dialog Box 

2. Click Browse next to Data File to display the Open Data File dialog box. 
3. Select the data file to use in the conversion process and click Open. 
4. Click Browse next to Map Specification to display the Open Map Specification dialog 

box. 
5. Select the map specification file to use in the conversion process and click Open. 
6. Click OK to generate CSV data file from the selected files. 

 
Click the Previous and Next buttons to cycle through the CSV data one at a time. As the 
data change, the validation messages change as well. See caAdapter Mapping Tool 
Validation for more information on the validation messages. Click the Regenerate button to 
regenerate the data from scratch using the same data file and map specification. 

Saving the CSV Data File 

Select File > Save or File > Save As from the menu bar, or click the Save icon on the tool 
bar, to save the data file. 
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Chapter 5 HL7 v2 to HL7 v3 Conversion 

This chapter provides instructions on using caAdapter to map and convert an HL7 v2 
message to an HL7 v3 message.  

Topics in this chapter include: 

• Understanding the Mapping and Transformation Processes on this page 
• Using the HL7 v2 to HL7 v3 Module on page 66 
• Advanced HL7 v2 to HL7 v3 Mapping on page 67 

Understanding the Mapping and Transformation Processes 
There are two major steps involved in converting an HL7 v2 message to an HL7 v3 
message: 

• Step 1: Map and convert the HL7 v2 message to CSV format 

• Step 2: Map and convert the CSV file (which is equivalent to the original HL7 v2 
format), to HL7 v3 format 

Figure 5-1 shows the entire conversion process and the sub-steps involved. 

 
 

 

Figure 5-1 HL7 v2 to HL7 v3 conversion steps 
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Mapping and Converting HL7 v2 to CSV Format 

The first step in the process involves using caAdapter to reproduce the HL7 v2 message 
in CSV format. The input files in this step are: 

1. HL7 v2 Message file 
2. HL7 v2 Resources file collection. Those include HL7 v2 specifications files to help 

parse the message. The Resources file collection includes four types of files which 
describe:  
• Message Structure 

• Data Type Specs 

• Segment Attributes 

• Vocabulary Definition 

The Resources file collection may vary depending on the version of the HL7 v2. This 
release of caAdapter includes the Resources file collections for HL7 v2.4 and HL7 v2.5. 
Update to the files reflects the exact “flavor” of the v2.4 or v2.5 used.   

The output files in this step are: 

1. CSV specification, or an .scs, file. This file defines a CSV file equivalent in structure 
to the HL7 v2 message. caAdapter detects the message type, retrieves its 
specifications from the Resources file collection, and creates the  corresponding 
CSV file. 

2. CSV data file. This file contains HL7 v2 data in CSV format that corresponds to the 
scs specification file described above. 

Mapping and Converting CSV File to HL7 v3 Format 

In the second step, caAdapter uses the files generated in step 1 to create the HL7 v3 
message. The input files in this step are: 

1. The CSV specification file created in Step 1. 
2. The CSV data file created in Step 1. 
2. H3s Files, which contain the specifications for HL7 v3 messages.  
4. Using caAdapter’s Mapping Tool, the user will map the data elements from the CSV 

file to the proper HL7 v3 message.  
 
Note: caAdapter cannot determine the target HL7 v3 message to which the source v2 
message is mapped. The user must have thorough understanding of both HL7 v2 
(source) and HL7 v3 (target) message structures to make this determination. 

 
The output files in this step are: 

1. CSV to HL7 v3 .map file. This file contains the mapping rules between the CSV file 
and HL7 v3. This file will be used by caAdapter’s Transformation Service to create 
the actual HL7 v3 message. 
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2. HL7 v3 Message. This file contains the transformed data in HL7 v3 format.  
 

Using the HL7 v2 to HL7 v3 Module 
This section describes the detailed instructions for using the HL7 v2 to v3 Module which 
is organized by the two major steps involved as listed in the previous section. 

Select File > New > HL7 v2 to HL7 v3 Conversion Service > HL7 v2 to scs & CSV 
Conversion (Figure 5-2). 

 
Figure 5-2 Launching the HL7 v2 to CSV Conversion Module 

Use the window in Figure 5-3 to define the input and output files needed to complete 
step one of the process. The top two input files are: 

• HL7 v2.x Resource file collection directory. This example uses the Resources file 
collection for HL7 v2.4. 

• HL7 v2.x message file 

The bottom two files are the output files that caAdapter will generate: 

• CSV File which contains the HL7 v2 message data presented in CSV format. 

• A CSV specification file that matches that of the HL7 v2 message. 

 
Figure 5-3 Creating the CSV and SCS Files that Correspond to the HL7 v2 Message 

Click the Process button. caAdapter presents a confirmation message that the two output files were 
created successfully ( 

 

Figure 5-4).  
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Figure 5-4 Confirmation Message 

In the second step, use the Mapping Module to map the .scs file created in step one to 
the appropriate HL7 v3 message. See Chapter 14 for detailed instructions on performing 
this task.  

Advanced HL7 v2 to HL7 v3 Mapping 
The Advanced HL7 v2 to HL7 v3 mapping option provides the following additional 
features. 

1. Create a CSV specification file without an actual HL7 v2 message. Specify the HL7 
v2 message type and trigger event. caAdapter then uses the Resources file 
collection to create the corresponding CSV specification file.  

2. Explicitly set up the OBX Segment in the CSV specification file. The OBX segment 
contains essential clinical information including lab results, X-ray image data, 
doctor’s comments, and others. Such information is captured into various OBX data 
types, i.e. ST for String, ED for Encapsulated Data, etc. caAdapter provides the 
capability to specify the exact OBX data types to include in the generated CSV 
specification file. 

Generating a CSV Specification File without an Actual HL7 v2 Message 

When the user specifies a message type that contains an OBX segment to generate a 
CSV Specification file, the “OBX Data Type Selection” on the bottom of the window 
becomes active (Figure 5-5). The following options determine the content of the 
generated CSV specification file. 

• Treat all OBX data types as an ST data type by selecting the ST Data Type Only 
radio button. 

• Group all OBX data types into an ST data type for simplification by selecting the Yes 
radio button in the “Grouping” block. 

• Specify the OBX data types to include by selecting the Selecting Data Types radio 
button and checking the data types to be included.  

Note: When the OBX data types are specified, e.g. ST and ED, caAdapter can only 
transform HL7 v2 messages that contain ST and ED OBX data types. If the user 
provides an HL7 v2 message containing OBX data types other than ST and ED, 
caAdapter will flag those as errors during the transformation process. 

Generating a CSV Specification File from an Actual HL7 v2 Message 

When the user provides an actual HL7 v2 message to create the CSV specification file, 
and the message contains OBX segments, the “OBX Data Type Selection” section on 
the bottom of the window becomes active. The following options determine the content 
of the generated CSV specification file: 
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• Include specifications that correspond to the actual OBX data types provided in the 
message by selecting the Apparent Data Type Only radio button. 

• Treat all OBX data types as ST data type by selecting the ST Data Type Only radio 
button. 

• Group the ST, TX, and FT OBX data types into a single ST data type for 
simplification by selecting the Yes radio button in the “Grouping” block. 

• Specify additional OBX data types to include by selecting the Selecting Data Types 
radio button and checking the data types to be included.  

 

Figure 5-5 Advanced HL7 v2 Converting Panel 

Figure 5-6 contains an example CSV specification file for an HL7 v2 message that contains 
two OBX data types: ST and ED. 
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Figure 5-6 Example Case of various forms of OBX segments 
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Chapter 6 Regulatory Data Services Module 

This chapter provides instructions on using the Regulatory Data Services Module (RDS). 
This module allows mapping existing data structures to generate regulatory-type data 
submission files. This version of caAdapter only supports creating SDTM files from a 
database or a CSV source. The user can use the Mapping Tool to map database tables, or 
a CSV files, structure to one or more SDTM domain structure. The transformation feature 
then transforms and generates corresponding SDTM domain files.  

Topics in this chapter include: 

• Understanding the Mapping and Transformation Processes on this page 
• Mapping a CSV File to SDTM Domain Structures on page 71 
• Generating SDTM Datasets from a CSV file on page 75 
• Editing an Existing Map File on page 76 
• Editing and Printing an Existing Map File on page 77 
• Mapping a Relational Database to SDTM Domain Structures on page 78 
• Generating SDTM Datasets from a Database on page 82 

Understanding the Mapping and Transformation Processes 
There are two steps involved in creating SDTM domain datasets from a database or 
.CSV files. First, the user must map the data elements from the source to their 
corresponding data elements in the SDTM domain structure(s). caAdapter will capture 
the mapping specifications in a .map file. The .map file can be edited at a later time if 
needed. Second, caAdapter will use the source and map specifications files to generate 
the SDTM dataset from the source data files. Those datasets will be stored in a flat file 
with a .txt extension. Figure 6-1illustrates the steps involved. Arrows marked with “1” 
and “2” correspond to the first and second steps listed above. 



  Chapter 6 Regulatory Data Services Module 

  71 

 

Figure 6-1 RDS Module Mapping and Transformation Processes  

Mapping a CSV File to SDTM Domain Structures 
This section contains detailed instructions for using the mapping tool to create a CSV-to-
SDTM .map file. 

1. Select File > New > RDS Mapping and Transformation Service > CSV/Database 
to RDS Map Specification (Figure 6-2). caAdapter presents a blank map 
specification tab (Figure 6-3). 

 
Figure 6-2 Launching the Mapping Tool for CSV to SDTM Mapping 
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Figure 6-3 Blank Map Specification tab 

2. Click the Open SCS File button on the left panel and select a .scs file (Figure 6-4). 
caAdapter will load the CSV specification file, or the .scs file, in the left panel (Figure 
6-5). 

 
Figure 6-4 Select a CSV File Specification (.scs File) 
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Figure 6-5 A CSV Specification file loaded in the left panel 

3. Click the Open SDTM Definition File button and select the define.xml file which 
contains SDTM Domain Specifications (Figure 6-6). caAdapter displays the SDTM 
Domain specifications in the right panel (Figure 6-7). 

 
Figure 6-6 Select  “define.xml” file 
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Figure 6-7 SDTM Domain Structure loaded in the right panel 

4. Using the mouse, drag a data element from the left panel and drop it over the 
corresponding field in the right panel. caAdapter draws a line linking the two 
elements depicting a mapping rule. Repeat the same procedure for the rest of the 
data elements in the left panel (Figure 6-8). This version of caAdapter supports 
mapping one CSV file to more than one SDTM domain. 
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Figure 6-8 Data Elements Mapped from the CSV to the SDTM Domain Structure 

5. Click the Save icon on the tool bar to save the mapping specifications to a .map file 
(Figure 6-9). 

 
Figure 6-9 Saving the Map file 

Generating SDTM Datasets from a CSV file 
Once the .map file is created, as presented in the previous section, caAdapter will use 
the .map and .CSV file to generate SDTM datasets. This section contains detailed 
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instructions on how to perform this task. 

1. Select File > New > RDS Mapping and Transformation Service > RDS Text File as 
shown in Figure 6-10. 

 
Figure 6-10 Launching the SDTM File Generation Process 

2. caAdapter opens the [Create RDS Text File] dialog box (Figure 6-11) for specifying 
the .map file.  

 
Figure 6-11 Selecting the .map file 

3. Once the .map file has been specified, caAdapter displays the SDTM Text File dialog 
box for specifying the CSV file containing the data, and the target directory where the 
SDTM file(s) will be saved (Figure 6-12).  

 
Figure 6-12 SDTM Text File 

4. Click the Transform button. caAdapter creates a SDTM data file(s) which 
corresponds to the CSV file using the .map file. A confirmation message is displayed 
(Figure 6-13). 

 
Figure 6-13 SDTM Data file was Created Successfully 

Editing an Existing Map File 
caAdapter provides the capability to edit a previously saved .map file. This section 
contains detailed instructions on how to perform this task. 
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1. Select File > Open > CSV/Database to RDS Map Specification (Figure 6-14).  

 
Figure 6-14 Launching the Edit Map File Feature 

2. Once the .map file is selected, the file opens in the Mapping Tool. The file is now 
ready to be edited (Figure 6-15). 

 

Figure 6-15 Mapping Tool with the Map File loaded 

Editing and Printing an Existing Map File 
Once a .map file has been created and saved, you can use caAdapter to edit the 
mapping specification. To edit the .map file select File > Open > CSV/Database to RDS 
Map Specification. Locate the .map file you wish to edit. caAdapter will display the file 
in the Mapping Tool. 

caAdapter also provides the capability to generate a report of the mapping specification 
in MS Excel format. You can use this feature from the Mapping Tool. Select Report > 
Generate Report from the main menu. caAdapter will create a .xls file capturing the 
mapping specification. 
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Mapping a Relational Database to SDTM Domain Structures 
caAdapter provides the capability to generate SDTM domain datasets from an existing 
database. The user can use the Mapping Tool to map various fields in the database 
tables to SDTM data elements in one or more domains. Once the mapping has been 
completed, the user can then use the Data Viewer utility to construct the SQL queries 
necessary for extracting the data from the database to create the SDTM datasets. 

This section contains detailed instructions on using caAdapter to map a relational 
database to SDTM domain structures. 

The first step is to define and create the database connection profile. The connection 
profile contains the necessary information for caAdapter to access the database. Please 
note that this version of caAdapter was only tested with an Oracle database.  

1. To create the profile, select File > New > RDS Mapping and Transformation 
Service > CSV/Database to RDS Map Specification as shown in Figure 6-16. 
caAdapter opens a blank map specification tab (Figure 6-17). 

 
Figure 6-16 Launching the Mapping Tool for CSV to SDTM Mapping 

 
Figure 6-17 Blank Map Specification Tab 

2. Click the Choose Database button. The Enter Connection Parameters dialog box 
displays (Figure 6-18).   

 Note: When caAdapter is opened for the first time, the left panel will not have any 
profiles listed. 
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Figure 6-18  Enter Connection Parameters dialog box 

3. Click the New Profile button. The New Profile dialog box displays. Fill in values for 
all fields specifying database connection information as shown in Figure 6-19. Click 
the OK button. This step creates the Connection Profile. To view the new profile you 
just created, double click the profiles folder; the new profile is displayed in Figure 
6-20. Once the profile has been created, caAdapter saves it for future use until it is 
deleted. Delete the profile by right-clicking on the profile name in the Enter 
Connection Profile’s left panel and select Delete Profile.  

 
Figure 6-19  New Profile Dialog Box 

 
Figure 6-20  New Profile information displayed 
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4. Fill in the password and click the Connect button. caAdapter accesses the database, 
reads the schema, and presents all tables and views that the user has been 
authorized to access in the left panel. Figure 6-21 shows an example database 
schema opened in the left panel of the Mapping Tool. 

 
Figure 6-21  Database Schema Displayed in the Left Panel 

5. Open the define.xml file to populate the right panel with SDTM domain structures. 
Use the Mapping Tool to map database columns to SDTM data elements as shown 
in Figure 6-22. 

 
Figure 6-22 Mapping Database Columns to SDTM Data Elements 
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6. Once the mapping is complete, click the Save button to save the map file. caAdapter 
displays a confirmation message, and provides the option to open the Data Viewer, 
Figure 6-23. The Data Viewer is a visual tool which uses the mapping information to 
assist the user in further refining the SWL queries needed to create the SDTM 
datasets. If the Data Viewer is not chosen for use, caAdapter creates the queries and 
adds them to the .map file. 

 
Figure 6-23  Option to Open the Data Viewer Tool 

7. When the Yes button is clicked in the previous step, caAdapter opens the Data 
Viewer tool. The Data Viewer has a tab for each SDTM domain used in the mapping. 
Each domain tab displays all database tables with columns used in the mapping. The 
“designer” view can be used with drag-and-drop features to add joins between 
tables, insert new tables, select additional fields, etc. The “syntax” view shows the 
constructed SQL query. The query can also be modified in the “syntax” view. See 
Figure 6-24 and Figure 6-25. The Data Viewer has additional capabilities that help 
with creating the queries to include validating and running the query. 

 
Figure 6-24  Data Viewer Module (Designer View) 
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Figure 6-25 Data Viewer Module (Syntax View) 

8. Once constructing the queries has been completed, click the Save ALL & Exit 
button. caAdapter updates the map file with the updated queries syntaxes. 

Generating SDTM Datasets from a Database 
This section contains details on generating SDTM datasets from a database based on 
the mapping completed in the previous sections 

1. Select File > New > RDS Mapping and Transformation Service > RDS Text File 
as illustrated in Figure 6-26. 

 

 
Figure 6-26 Launching the SDTM File Generation Process 

2. The Create RDS Text File window opens (Figure 6-27), which allows specifying the 
.map file.  

 
Figure 6-27 Selecting the .map file 
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3. Provide caAdapter with the password to the connection profile to access the 
database and with the directory where caAdapter can store SDTM datasets. See 
Figure 6-28 and Figure 6-29. 

 
Figure 6-28 Entering Database Password 

 
Figure 6-29 Specifying Directory to Store Generated SDTM Datasets 

4. Specify whether the SDTM datasets generated contains fixed length columns or not 
by selecting Tool > Preferences. In the RDMS Module tab select Fixed Length and 
click OK (Figure 6-30). If this option is selected, and prior to generating SDTM 
datasets, a dialog box opens to specify the length of every SDTM column used in the 
mapping (Figure 6-31).  
 
Note: caAdapter will pad the fields with trailing spaces when the data is shorter than 
the field length specified. 
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Figure 6-30 Fixed Length Columns Option 

 
Figure 6-31 Entering Column Lengths 

5. Once the transformation is completed, caAdapter creates one file per SDTM domain. 
Figure 6-32 shows the SDTM datasets generate in the specified directory in step 3 
above. 

 
Figure 6-32 SDTM Datasets 
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Chapter 7 caAdapter Model Mapping Service 

This chapter describes how to use caAdapter to facilitate object to database mapping.  

Topics in this chapter include:  

• Overview on this page 
• Using the caAdapter Model Mapping Service on this page 
• The Seven Mapping Scenarios on page 94 
• User Interface Legend on page 99 

Overview 
The caAdapter 4.0 Model Mapping Service for the caCORE 3.2 SDK takes advantage of the 
caAdapter mapping infrastructure to facilitate object to database mapping. The model 
mapping service requires an .xmi file (with full Enterprise Architect [EA] roundtrip capability) 
that includes a data model and object model as inputs. The service module loads all models 
into the tool. Object to database mapping is done by dragging object model elements and 
dropping them onto target data model elements. Once mapping is complete, caAdapter adds 
SDK-required values as TaggedValues to the original xmi file (and, for backwards 
compatibility, also creates a .map file). After importing the newly tagged xmi file into EA and 
exporting an xmi 1.1-compatible file, the caCORE SDK can perform all code generation 
tasks. 

Using the caAdapter Model Mapping Service 
The caAdapter Model Mapping Service provides the following functionalities:  

• Parse and load data model and object model from an xmi file 

• Drag and drop mapping between an object model and a data model 

• Add SDK required tags and tag values into an xmi file 

• Generate Hibernate mapping file 

The following diagram (Figure 7-1) describes the overall flow of how the caAdapter Model 
Mapping Service is integrated with other components. caAdapter users need to first develop 
an object model and a data model in EA. An xmi file needs to be exported from EA and then 
the caAdapter Model Mapping Service can load the xmi file. caAdapter users will map objects 
to tables, and attributes and associations to columns by dragging and dropping. Once 
completed, caAdapter can directly generate a set of Hibernate HBM mapping files. 
Alternatively, the original xmi file which has caCORE compliant tag values added can be 
saved for later use. The tagged xmi file can be reimported into EA to generate an xmi file that 
can be used by the caCORE SDK. 

The following subsections describe each of these steps in detail. 
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Figure 7-1 caAdapter Model Mapping Service Overall Process 

Note: While it still supports the .map file, this version of caAdapter does not require it; all 
mapping information is now stored in the .xmi file. 

Exporting an XMI file from EA 

Before beginning to map between an object model and a data model through the caAdapter 
Model Mapping Service, an xmi file needs to be generated through EA by following these 
steps. 

1. Open the .eap file (that contains the object and data models) and right click on 
Logical View. Select Import/Export > Export package to XMI file  (Figure 7-2). 

 
Figure 7-2  Export XMI file from EA 

2. On the Export Package to XMI window, check the Format XMI Output box and the 
Enable Full EA Roundtrip box. Specify the output file name of the xmi file and click 
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Export. The generated xmi file can be parsed by the caAdapter Model Mapping 
Service module (Figure 7-3). 

 
Figure 7-3  Options to export XMI file from EA 

Creating an Object Model to Data Model Map Specification 

Perform the following steps to create a new map specification.  

1. Select File > New > Model Mapping Service > Object Model to Data Model Map 
Specification (Figure 7-4) to open a new mapping tab with empty source and 
destination panels. 

2. Click Open XMI file… to display the Open XMI file … dialog box (Figure 7-5). Select 
the XMI file to start mapping an object model to a data model. 

 

 

Figure 7-4 Creating an Object Model to Data Model Map Specification 
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3. After the xmi file is loaded, the object model opens in the left panel, and the data 
model displays in the right panel. Start mapping objects and attributes to tables 
and columns. 

 

 

Figure 7-5 Open XMI file 

Opening an Existing Object to Database Mapping Specification 

Perform the following steps to open an existing map specification.  

1. Select File > Open > Object Model to Data Model Map Specification. The Open 
Map File dialog box displays. 

2. Select either the xmi file or the map specification file and click Open. (For backwards 
compatibility, caAdapter 4.0 saves the mappings in the .map file as well as the xmi 
file, so either may be used to open the mapping specification). 

3. If you select a .map file and the xmi associated with the mapping cannot be found, 
the Select xmi file dialog box opens. Browse to the correct xmi file and click Open. 
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Basic Mapping 

Perform the following steps to create an object to database mapping specification 
(dependency mapping, attribute mapping, and association mapping).  

1. Select a source element (objects, attributes, or associations) from the Object Model 
and drag it to the appropriate target element (tables, columns or foreign keys) in the 
Data Model. The cursor indicates whether the source element is, or is not, allowed to 
be mapped to the target element (Figure 7-6). Drop the source element on the target 
element. 

 

 

Figure 7-6 Cursor indicates whether mapping is allowed 

2. Once a source element is mapped to a target element, a mapping line appears 
between them in the mapping panel. Figure 7-7 shows a mapping line between 
Amendment in the Object Model, on the left, and Amendment in the Data Model, on 
the right.   

 

Figure 7-7 Mapping line between source element and target element 

Dependency Mapping (Object to Table) 

A dependency mapping is a mapping between an object and a table. Perform the following 
steps to create a dependency mapping.  

1. Select a source element from the Object Model on the right. The example in Figure 
7-8 shows HealthcareSite. Click and drag to HealthcareSite to HEALTHCARE_SITE 
in the Data Model. 

2. A mapping line between HealthcareSite in the Object Model and 
HEALTHCARE_SITE in the Data Model should now be visible. Dependency 
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mapping lines are color-coded green.   
 

 

Figure 7-8 Dependency Mapping 

Attribute Mapping 

An attribute mapping is a mapping between an attribute in the object model and a 
column in the data model. (Before any attribute mapping can be performed, users have 
to complete dependency mapping first) Perform the following steps to create an attribute 
mapping. 

1. The example in Figure 7-9 shows the attribute id (A) for the class HealthcareSite. 
Select 'id (A)' in the Object Model and drag it to ID in the Data Model.  

2. A mapping line should be visible between the attribute and column. Attribute 
mapping lines are color-coded blue. Repeat this for 'name (A)' to NAME.  

 

 

Figure 7-9  Attribute Mapping 

3. If the object has not already been mapped to the table, an attempt to map the 
object’s attributes to the table’s columns will result in an error message (Figure 7-10). 

 

 

Figure 7-10  Attribute Mapping error message 
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Association Mapping 

An association mapping is a mapping between one end of an association listed under an 
object in the object model and a foreign key column in a table in the data model. Perform the 
following steps to create an association mapping.  

1. First create a dependency mapping between the object model and the data model. 
For example, in Figure 7-11 the green line shows a dependency between 
'HealthcareSite' and ‘HEALTHCARE_SITE’. 

2. Map 'id (A)' to ID and 'name (A)' to  NAME. 
3. Click and drag 'address (1 to 1)' to ADDRESS_ID. When complete, the final result 

should look like Figure 7.11.  Association mapping lines are color-coded red. 
 

 

Figure 7-11  Association Mapping 

Deleting Mapping Lines 

Perform the following steps to delete a mapping line.  

1. Select the mapping line by left clicking on it in the mapping panel. The line is 
highlighted. 

2. Right click on the highlighted mapping line and select Delete (Figure 7.12). The line 
is removed from the mapping panel. 

 

 

Figure 7-12 Deleting Mapping Lines 

Validating Mapping Specifications 

Validating a mapping specification identifies any pertinent business rules that have been 
violated and indicates any changes that need to be made. Perform the following steps to 
validate the object to database mapping specification. 

1. Click the Validate button (top of Figure 7.13). The following message displays: 
“Validation process completed successfully with no message received”. If there are 
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errors in the validation process, the following message displays: “Validation process 
completed but received <some number> ERRORs”. 

2. If there are errors the Message Dialog (bottom of Figure 7.13) window opens and 
allows examination of any messages, errors, or warnings. Error messages may 
identify what actions to perform to correct errors, while warnings and informational 
messages may require no changes at all. It is recommended that mappings be re-
validated after changes are made. 

 

 
Figure 7-13 Validate Mapping Specification  

Saving Mapping Specifications 

To save a mapping specification, select File > Save. caAdapter saves the mappings to the 
xmi file and to the .map file (for backward compatibility). The Save Complete dialog displays 
when completed. 

The xmi file created can be used by the caCORE SDK for code generation purposes. 

Generating Hibernate Mappings 

An alternative to creating caCORE SDK APIs is to generate Hibernate files and use 
those files in an application to access data from a database. Perform the following steps 
to generate Hibernate files from the current object to database mapping. 

1. Click the Generate HBM Files button; the Open dialog box displays (Figure 7-14). 
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2. Select a directory to save the HBM file(s) and click Open. 
3. The HBM files are saved to the directory specified. 
. 

 

Figure 7-14 Generate HBM Files 

The Seven Mapping Scenarios 
Before performing any of the following mapping scenarios, all dependency mappings 
between objects and tables have to be completed. 

One‐to‐One Bi‐Directional 

To map one-to-one bi-directional relationships, the rule is to map the association from 
the object whose corresponding table has the foreign key (source) to the foreign key in 
the corresponding table (target).  In the example (Protocol and Amendment) in Figure 
7-20, drag the association (Amendment.protocol (1 to 1)) and drop it onto the foreign key 
(PROTOCOL_ID) of the corresponding table (AMENDMENT). For one-to-one bi-
directional mapping, only one end of the relationship needs to be mapped; the other end 
(Protocol.amendment (1 to 1)) does not need to be mapped.  
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Figure 7-15 One‐to‐One Bi‐Directional Mapping 

One‐to‐One Uni‐Directional 

To map one-to-one uni-directional relationships, the rule is to map the association from 
the object whose corresponding table has the foreign key (source) to the foreign key in 
the corresponding table (target). In the example (HealthcareSite and Address) in Figure 
7-16, drag the association (HealthcareSite.address (1 to 1)) and drop it onto the foreign 
key (ADDRESS_ID) of the corresponding table (HEALTHCARE_SITE). 

 

Figure 7-16 One‐to‐One Uni‐Directional Mapping 

One‐to‐Many Bi‐Directional 

To map one-to-many bi-directional relationships, the rule is to map the association from the 
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object whose corresponding table has the foreign key (source) to the foreign key in the 
corresponding table (target). In the example (AdverseEvent and AdverseEventTherapy) in 
Figure 7-17, drag the association (AdverseEventTherapy.adverseEvent (1 to Many)) and 
drop it onto the foreign key (ADVERSE_EVENT_ID) of the corresponding table 
(ADVERSE_EVENT_THERAPTY). For one-to-many bi-directional mapping, the other end of 
the association will be rendered by a dark blue element, and is not required to be mapped 
through caAdapter. 

 

Figure 7-17 One‐to‐Many Bi‐Directional Mapping 

One‐to‐Many Uni‐Directional 

To map one-to-many uni-directional relationships, the rule is to map the association from 
the object whose corresponding table has the foreign key (source) to the foreign key in 
the corresponding table (target). In the example (CancerStage and Diagnosis) in Figure 
7-18, drag the association (CancerStage.diagnosis (1 to Many)) and drop it onto the foreign 
key (DIAGNOSIS_ID) of the corresponding table (CANCER_STAGE). For one-to-many uni-
directional mapping, the other end of the association will be rendered by a dark blue element, 
and is not required to be mapped through caAdapter. The pink color-coded association end is 
added by the system to support mapping and should be mapped, but the dark blue 
association end should not be mapped. 
 

 

Figure 7-18 One‐to‐Many Uni‐Directional Mapping 
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Many‐to‐One Uni‐Directional 

To map many-to-one uni-directional relationships, the rule is to map the association from 
the object whose corresponding table has the foreign key (source) to the foreign key in 
the corresponding table (target). In the example (HistopathologyGrade and Histopathology) 
in Figure 7-19, mapping is done in a similar fashion as the one-to-many uni-directional 
relationship. Drag the association (HistopathologyGrade.histopathCollection (1 to Many)) and 
drop it onto the foreign key (HISTOPATHOLOGY_ID) of the corresponding table 
(HISTOPATHOLOGY_GRADE). 

 

Figure 7-19 Many‐to‐One Uni‐Directional Mapping 

Many‐to‐Many Bi‐Directional 

To map a many-to-many bi-directional association, first identify an intersection table. In 
the example in Figure 7-20, STUDY_SITE_PARTICIPANT is the intersection table 
(typically the name of the intersection table is a concatenation of the two tables that 
correspond to the two objects). Then, drag both ends of the associations and drop them 
onto the two corresponding columns in the mapping table. 
 

 

Figure 7-20 Many‐to‐Many Bi‐Directional Mapping 
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Many‐to‐Many Uni‐Directional 

To map a many-to-many uni-directional association, first identify an intersection table. In 
the example in Figure 7-21, ASSESSMENT_OBSERVATION is the intersection table 
(typically the name of the intersection table is a concatenation of the two tables that 
correspond to the two objects). Then, drag both ends of the associations and drop them 
onto the two corresponding columns in the intersection table (just like for a bi-directional 
association). 

 

Figure 7-21 Many‐to‐Many Uni‐Directional Mapping 

Mapping Inheritance 

To map inheritance through the caAdapter Model Mapping Service, following the above 
steps to map each child class or attribute to its corresponding table or column, and the 
tool will automatically mark inherited attributes as (A – Derived). Those attributes do not 
need to be mapped, and during the validation, an information level message is 
displayed. 
 

 

Figure 7-22  Mapping with Inheritance 
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User Interface Legend 

Node Details 

• (A) – The node is an attribute 

• (A – Derived) –The node is an inherited attribute 

• (1 to 1) – The node is a one-to-one association 

• (1 to Many) – The node is a-one-to many association 

• (Many to 1) – The node is a many-to-one association 

• (Many to Many) – The node is a many-to-many association 

Mapping Line Colors 

• Green – Dependency Mapping. 

• Blue – Attribute Mapping.  

• Red – Association Mapping. 

 

Figure 7-23 Mapping Line Colors 

The following icons are used to indicate various element tagging as discussed in the 
next section: 

Lazy -  Eager -  

CLOB -  Discriminator -  

Primary Key -    

Additional Module Features 

To tag a column in the data model as Lazy-Load, CLOB, or Discriminator, click on the 
column and select the appropriate tag (Figure 7-24).  

Note: This version of caAdapter supports mapping more than one object to a single 
table. However, at least one column in that table must be tagged as a “Discriminator”.  
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Figure 7-24  Tagging a Column with Lazy, CLOB, or Discriminator 

Only one attribute can be tagged in an object as a Primary Key. Right click on the 
attribute and select Make Primary Key. If no primary key was specified, caCORE SDK 
will assume that the field with the name “id” is the primary key (Figure 7-25).  

 

Figure 7-25 Designating a Primary Key for an Object 

Specify the prefix to use for Object or Data Model elements using the Tools > 
Preferences menu option (Figure 7-26). 

 

Figure 7-26 Designating Prefixes 

The following table show various tags implemented by caAdapter.  



  Chapter 7 caAdapter Model Mapping Service 

  101 

 

Tag Name Tag Value Location 

id-attribute Fully qualified class name Class attribute 

mapped-attributes Fully qualified attribute name Table column 

implements-
association 

Fully qualified association name Table column (foreign key) 

inverse-of Fully qualified association name Table column (foreign key) 

discriminator Fully qualified class name (when 
used on the column), 

Discriminating value (when used on 
the class) 

Table column (foreign key), 

Class 

correlation-table Join table name Association 

documentation Comments on the class or attribute Class or Attribute of class 

description Comments on the class or attribute Class or Attribute of class 

Lazy-load Yes/No Association 

Type CLOB Table column. 
Corresponding class 
attribute must be String 
type) 

Table 7-1 caAdapter Implemented Tags 
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Chapter 8 Using Functions in Mapping 

This chapter describes the different functions provided by caAdapter.  

Topics in this chapter include: 

• Functions Provided by caAdapter on this page 
• Function Specifications on page 104 
• Adding Functions to the Function Library on page 114 

Functions Provided by caAdapter 
caAdapter provides a variety of basic functions as part of the initial installation. These 
functions may be used in any mapping where the function panel is available. There are five 
groups of functions: 

• constant – There is one function in this group that allows the user to define a value 
that can be used as input with other functions 

• date – There is one function in this group that allows the user to convert any date 
format into the HL7 v3 required date format. 

• math – Five basic math functions are provided in this group. 

• string – Ten commonly used functions in this group allows users to do basic data 
manipulation. 

• vocabulary – These functions were new in the 4.0 release of caAdapter and allow a 
user to translate values in incoming data into a different value in the outgoing format. 

The following table provides a simple overview of the functions that reside in each of these 
groups. 

Function 
Group Name 

Function Name Function Description 

constant Constant Allows the user to define a string or integer for use 
as an input value to another function or to a target 
field. 

Date changeFormat Requires the user to define the incoming date 
format (using either a constant function or a source 
field mapping) and the date field to be converted. 
Only transforms to the HL7 v3 required date 
format, but does handle varying levels of specificity 
(e.g. with or without time). 

math Addition Takes in two values and provides the sum. 

math Subtract Takes in two values and provides the difference. 

math Multiply Takes in two values and provides the product. 

math Divide Takes in two values and provides the quotient. 
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Function 
Group Name 

Function Name Function Description 

math Round Takes in two values, a value to be rounded, and 
the digit number to which to round.  

string Concatenate Takes in two strings and provides a single value 
have the first string appended with the second. 

string Split Takes in a string and a position number and breaks 
the string into two strings at the given position. 

string Length Takes in a single string and provides the number of 
characters present. 

string Substring Takes in a string and a starting and ending 
position, returning a portion of the string. 

string Trim Takes in a single string and provides the same 
basic value with leading and trailing blanks 
removed.  

string Replace Takes in three strings, one containing the value to 
be operated on, one containing the “from” 
characters to search for, and the last containing the 
“to” characters to substitute, producing a single 
string with “from” characters substituted with “to” 
characters. 

string Instring Takes in a string on which to operate and a pattern 
to search for, returning the position within the string 
where the pattern is found, or 0.  

string Upper Takes in a single string and returns the same string 
only with all alphabetic characters in uppercase.  

string Lower Takes in a single string and returns the same string 
only with all alphabetic characters in lowercase. 

string Initcap Takes in a single string and returns the same string 
only with all alphabetic characters in lowercase 
except the first which is in uppercase. 

vocabulary translateValue Requires the user to select either a vocabulary 
mapping file (.vom) or a URL to use as the basis of 
the conversion. Also may require a domain to be 
specified if the .vom file has more than one 
translation set in it. Takes in a single string and 
returns a converted string based on the “from” and 
“to” values and business rules defined in the 
vocabulary mapping file or the URL-based function. 
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Function 
Group Name 

Function Name Function Description 

vocabulary translateInverseValue Behaves the same way as the translateValue 
function only in reverse, matching the input value 
to the “to” side of the vocabulary mappings and 
returning the value from the “from” side. 

Table 8-1 caAdapter Functions 

Function Specifications 
There are two function-related specifications. The first one describes the function groups 
and functions, and the inputs, outputs and implementation for each function. The second 
one describes the vocabulary mappings used by the vocabulary functions. 

Function Specification Overview 

The function specification is used as a guide for function objects to read the function 
specification and determine what objects to call to execute a function (for example, 
concatenation). The function specification also stores data points for rendering by a 
function graphical representation within the mapping tool. It uses the following types of 
nested elements:  

<function> 

<group name> 

<function name> 

<inputs> 

<datapoint> 

<outputs> 
 

Following is an example of a function specification file (core.fls). See the {home 
directory}\map\functions directory for the entire file. 

<?xml version="1.0"?>  
<functions>  
    <group name="constant" xmlPath="constant">  
                <function name="constant" 
xmlPath="constant.constant">  
                        <outputs>  
                                <datapoint pos="0" name="constant" 
datatype="string" xmlPath="constant.constant.outputs.0"/> 

                        </outputs>  
                </function>  
    </group>  
    <group name="date" xmlPath="date">  
                <function name="changeFormat" 
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xmlPath="date.changeFormat">  
                        <inputs>  
                                <datapoint pos="0" name="fromFormat" 
datatype="string" xmlPath="date.changeFormat.inputs.0"/> 

                                <datapoint pos="1" name="dateIn" 
datatype="string" xmlPath="date.changeFormat.inputs.1"/> 

                        </inputs>  
                        <outputs>  
                                <datapoint pos="0" name="dateOut" 
datatype="string" xmlPath="date.changeFormat.outputs.0"/> 

                        </outputs>  
                        <implementation 
classname="gov.nih.nci.caadapter.common.function.DateFunction" 
method="changeFormat"/> 

                </function>  
        <function name="countDays" xmlPath="date.countDays">  
                        <inputs>  
                                <datapoint pos="0" name="fromDate" 
datatype="string" xmlPath="date.countDays.inputs.0"/> 

                                <datapoint pos="1" name="toDate" 
datatype="string" xmlPath="date.countDays.inputs.1"/>  
                        </inputs>  
                        <outputs>  
                                <datapoint pos="0" name="dayNumber" 
datatype="int" xmlPath="date.countDays.outputs.0"/>  
                        </outputs>  
                        <implementation 
classname="gov.nih.nci.caadapter.common.function.DateFunction" 
method="countDays"/> 

                </function>  
    </group>  
        <group name="math" xmlPath="math">  
                <function name="Addition" xmlPath="math.Addition">  
                        <inputs>  
                                <datapoint pos="0" name="Value1" 
datatype="double" xmlPath="math.Addition.inputs.0"/>  
                                <datapoint pos="1" name="Value2" 
datatype="double" xmlPath="math.Addition.inputs.1"/>  
                        </inputs>  
                        <outputs>  
                                <datapoint pos="0" name="Sum" 
datatype="double" xmlPath="math.Addition.outputs.0"/>  
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                        </outputs>  
                        <implementation 
classname="gov.nih.nci.caadapter.common.function.MathFunction" 
method="add"/>  
                </function>  
                <function name="Subtract" xmlPath="math.Subtract">  
                        <inputs>  
                                <datapoint pos="0" name="Value1" 
datatype="double" xmlPath="math.Subtract.inputs.0"/>  
                                <datapoint pos="1" name="Value2" 
datatype="double" xmlPath="math.Subtract.inputs.1"/>  
                        </inputs>  
                        <outputs>  
                                <datapoint pos="0" name="Difference" 
datatype="double" xmlPath="math.Subtract.outputs.0"/> 

                        </outputs>  
                        <implementation 
classname="gov.nih.nci.caadapter.common.function.MathFunction" 
method="subtract"/> 

                </function>  
                <function name="Multiply" xmlPath="math.Multiply">  
                        <inputs>  
                                <datapoint pos="0" name="Value1" 
datatype="double" xmlPath="math.Multiply.inputs.0"/>  
                                <datapoint pos="1" name="Value2" 
datatype="double" xmlPath="math.Multiply.inputs.1"/>  
                        </inputs>  
                        <outputs>  
                                <datapoint pos="0" name="Product" 
datatype="double" xmlPath="math.Multiply.outputs.0"/>  
                        </outputs>  
                        <implementation 
classname="gov.nih.nci.caadapter.common.function.MathFunction" 
method="multiply"/> 

                </function>  
                <function name="Divide" xmlPath="math.Divide">  
                        <inputs>  
                                <datapoint pos="0" name="Dividend" 
datatype="double" xmlPath="math.Divide.inputs.0"/>  
                                <datapoint pos="1" name="Divisor" 
datatype="double" xmlPath="math.Divide.inputs.1"/>  
                        </inputs>  
                        <outputs>  
                                <datapoint pos="0" name="Quotient" 
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datatype="double" xmlPath="math.Divide.outputs.0"/>  
                        </outputs>  
                        <implementation 
classname="gov.nih.nci.caadapter.common.function.MathFunction" 
method="divide"/> 

                </function>  
                <function name="Round" xmlPath="math.Round">  
                        <inputs>  
                                <datapoint pos="0" name="Input" 
datatype="double" xmlPath="math.Round.inputs.0"/>  
                <datapoint pos="1" name="roundDigit" datatype="int" 
xmlPath="math.Round.inputs.1"/>  
                        </inputs>  
                        <outputs>  
                                <datapoint pos="0" name="Output" 
datatype="double" xmlPath="math.Round.outputs.0"/>  
                        </outputs>  
                        <implementation 
classname="gov.nih.nci.caadapter.common.function.MathFunction" 
method="round"/>  
                </function>  
        </group>  
        <group name="string" xmlPath="string">  
                <function name="Concatenate" 
xmlPath="string.Concatenate">  
                        <inputs>  
                                <datapoint pos="0" name="String1" 
datatype="string" xmlPath="string.Concatenate.inputs.0"/> 

                                <datapoint pos="1" name="String2" 
datatype="string" xmlPath="string.Concatenate.inputs.1"/> 

                        </inputs>  
                        <outputs>  
                                <datapoint pos="0" name="Result" 
datatype="string" xmlPath="string.Concatenate.outputs.0"/> 

                        </outputs>  
                        <implementation 
classname="gov.nih.nci.caadapter.common.function.StringFunction" 
method="concat"/> 

                </function>  
                <function name="Split" xmlPath="string.Split">  
                        <inputs>  
                                <datapoint pos="0" name="String1" 
datatype="string" xmlPath="string.Split.inputs.0"/>  
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                                <datapoint pos="1" name="Pos" 
datatype="int" xmlPath="string.Split.inputs.1"/>  
                        </inputs>  
                        <outputs>  
                                <datapoint pos="0" name="Result1" 
datatype="string" xmlPath="string.Split.outputs.0"/>  
                                <datapoint pos="1" name="Result2" 
datatype="string" xmlPath="string.Split.outputs.1"/>  
                        </outputs>  
                        <implementation 
classname="gov.nih.nci.caadapter.common.function.StringFunction" 
method="split"/> 

                </function>  
                <function name="Length" xmlPath="string.Length">  
                        <inputs>  
                                <datapoint pos="0" name="String" 
datatype="string" xmlPath="string.Length.inputs.0"/>  
                        </inputs>  
                        <outputs>  
                                <datapoint pos="0" name="Length" 
datatype="int" xmlPath="string.Length.outputs.0"/>  
                        </outputs>  
                        <implementation 
classname="gov.nih.nci.caadapter.common.function.StringFunction" 
method="length"/> 

                </function>  
                <function name="Substring" 
xmlPath="string.Substring">  
                        <inputs>  
                                <datapoint pos="0" name="String" 
datatype="string" xmlPath="string.Substring.inputs.0"/> 

                                <datapoint pos="1" name="StartPos" 
datatype="int" xmlPath="string.Substring.inputs.1"/>  
                                <datapoint pos="2" name="EndPos" 
datatype="int" xmlPath="string.Substring.inputs.2"/>  
                        </inputs>  
                        <outputs>  
                                <datapoint pos="0" name="Result" 
datatype="string" xmlPath="string.Substring.outputs.0"/> 

                        </outputs>  
                        <implementation 
classname="gov.nih.nci.caadapter.common.function.StringFunction" 
method="substring"/> 
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                </function>  
                <!-- function name="Trim" xmlPath="string.Trim">  
                        <inputs>  
                                <datapoint pos="0" name="String" 
datatype="string" xmlPath="string.Trim.inputs.0"/>  
                        </inputs>  
                        <outputs>  
                                <datapoint pos="0" name="Result" 
datatype="string" xmlPath="string.Trim.outputs.0"/>  
                        </outputs>  
                        <implementation 
classname="gov.nih.nci.caadapter.common.function.StringFunction" 
method="trim"/> 

                </function -->  
                <function name="Replace" xmlPath="string.Replace">  
                        <inputs>  
                                <datapoint pos="0" name="String" 
datatype="string" xmlPath="string.Replace.inputs.0"/>  
                                <datapoint pos="1" name="FromStr" 
datatype="string" xmlPath="string.Replace.inputs.1"/>  
                <datapoint pos="2" name="ToStr" datatype="string" 
xmlPath="string.Replace.inputs.2"/>  
            </inputs>  
                        <outputs>  
                                <datapoint pos="0" name="Result" 
datatype="string" xmlPath="string.Replace.outputs.0"/>  
                        </outputs>  
                        <implementation 
classname="gov.nih.nci.caadapter.common.function.StringFunction" 
method="replace"/> 

                </function>  
                <function name="Instring" xmlPath="string.Instring">  
                        <inputs>  
                                <datapoint pos="0" name="String" 
datatype="string" xmlPath="string.Instring.inputs.0"/>  
                                <datapoint pos="1" name="Pattern" 
datatype="string" xmlPath="string.Instring.inputs.1"/> 

                        </inputs>  
                        <outputs>  
                                <datapoint pos="0" name="Result" 
datatype="int" xmlPath="string.Instring.outputs.1"/>  
                        </outputs>  
                        <implementation 
classname="gov.nih.nci.caadapter.common.function.StringFunction" 
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method="instring"/> 

                </function>  
                <function name="Upper" xmlPath="string.Upper">  
                        <inputs>  
                                <datapoint pos="0" name="String" 
datatype="string" xmlPath="string.Upper.inputs.0"/>  
                        </inputs>  
                        <outputs>  
                                <datapoint pos="0" name="Result" 
datatype="string" xmlPath="string.Upper.outputs.0"/>  
                        </outputs>  
                        <implementation 
classname="gov.nih.nci.caadapter.common.function.StringFunction" 
method="upper"/> 

                </function>  
                <function name="Lower" xmlPath="string.Lower">  
                        <inputs>  
                                <datapoint pos="0" name="String" 
datatype="string" xmlPath="string.Lower.inputs.0"/>  
                        </inputs>  
                        <outputs>  
                                <datapoint pos="0" name="Result" 
datatype="string" xmlPath="string.Lower.outputs.0"/>  
                        </outputs>  
                        <implementation 
classname="gov.nih.nci.caadapter.common.function.StringFunction" 
method="lower"/> 

                </function>  
                <function name="Initcap" xmlPath="string.Initcap">  
                        <inputs>  
                                <datapoint pos="0" name="String" 
datatype="string" xmlPath="string.Initcap.inputs.0"/>  
                        </inputs>  
                        <outputs>  
                                <datapoint pos="0" name="Result" 
datatype="string" xmlPath="string.Initcap.outputs.0"/>  
                        </outputs>  
                        <implementation 
classname="gov.nih.nci.caadapter.common.function.StringFunction" 
method="initcap"/> 

                </function>  
        </group>  
    <group name="vocabulary" xmlPath="vocabulary">  
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                <function name="translateValue" 
xmlPath="vocabulary.translateValue">  
                        <inputs>  
                                <datapoint pos="0" name="dataIn" 
datatype="string" xmlPath="vocabulary.translateValue.inputs.0"/> 

                        </inputs>  
                        <outputs>  
                                <datapoint pos="0" name="dataOut" 
datatype="string" xmlPath="vocabulary.translateValue.outputs.0"/> 

                        </outputs>  
                        <implementation 
classname="gov.nih.nci.caadapter.common.function.FunctionVocabularyM
apping" method="translateValue"/> 

                </function>  
        <function name="translateInverseValue" 
xmlPath="vocabulary.translateInverseValue">  
                        <inputs>  
                                <datapoint pos="0" name="dataIn" 
datatype="string" 
xmlPath="vocabulary.translateInverseValue.inputs.0"/> 

                        </inputs>  
                        <outputs>  
                                <datapoint pos="0" name="dataOut" 
datatype="string" 
xmlPath="vocabulary.translateInverseValue.outputs.0"/> 

                        </outputs>  
                        <implementation 
classname="gov.nih.nci.caadapter.common.function.FunctionVocabularyM
apping" method="inverseTranslateValue"/> 

                </function>  
    </group>  
</functions>  

Vocabulary Mapping Specification Overview 

The vocabulary mapping specification is used as a guide for translating values from one 
vocabulary set to another. It includes one or more vocabulary domain names with associated 
translations (source and target values) and a mechanism for handling cases where the 
incoming value does not match any of the mapped values.  

The vocabulary mapping specification uses the following types of nested elements:  

1. <VocabularyMapping> 
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2. <comment> 

3. <domain> 

4. <translation> 

5. <source> 

6. <target> 

7.   <elseCase> 

8.   <inverseElseCase> 
 
The elsecase and inverseElseCase elements can have several types which govern what 
happens when an incoming value doesn’t match any of the maps. Some of the flavors 
also include a value that the mapping can define for that case. The types include the 
following: 

Else Case Type Description Includes a Value? 

keepValue Returns the incoming value without 
any change 

No 

null Returns a null No 

assignValue Returns the value provided in the 
value attribute 

Yes 

makeAnError Returns an error status to cause 
caAdapter to report a vocabulary 
mapping error 

No 

Table 8-2 Else Case types 

Following is an example of a vocabulary mapping specification file (using the designated 
file extension, .vom). See the {home directory}\workingspace\examples\V2V3 
Mapping Examples\ADT_A03_to_402003  file for a soft copy of this code and see 
the {home directory}\etc functions file for the vom.xsd file that governs the 
structure of the .vom file. 

<?xml version="1.0" encoding="UTF-8"?> 

<VocabularyMapping name="Test_Example01> 

    <comment> 

        This vom file was made for test instance of V2-V3 mapping 

        which is between ADT^A03 and PRPA_MT402003  

    </comment> 

    <domain name="AdministrativeGender"> 

 <comment> 

         Source:HL70001(Administrative Sex), 

Target:2.16.840.1.113883.11.1(AdministrativeGender) 
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 </comment> 

         <translation name="Male"> 

                <source value="M" remark="Male"/> 

                <target value="M" remark="Male"/> 

         </translation> 

         <translation name="Female"> 

                <source value="F" remark="Female"/> 

                <target value="F" remark="Female"/> 

         </translation> 

         <translation name="unknown1"> 

                <source value="U" remark="Unknown"/> 

                <target value="UN" remark="Undifferentiated"/> 

         </translation> 

         <translation name="unknown2"> 

                <source value="O" remark="Other"/> 

                <target value="UN" remark="Undifferentiated"/> 

         </translation> 

         <translation name="unknown3"> 

                <source value="A" remark="Ambiguous"/> 

                <target value="UN" remark="Undifferentiated"/> 

         </translation> 

         <translation name="unknown4"> 

                <source value="N" remark="Not applicable"/> 

                <target value="UN" remark="Undifferentiated"/> 

         </translation> 

         <elseCase type="keepValue"/> 

         <inverseElseCase type="assignValue" value="UN"/>  

 

    </domain> 

    <domain name="DiseaseCodingSystemOID"> 
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         <translation name="ICD-10"> 

                <source value="I10"/> 

                <target value="2.16.840.1.113883.6.3"/> 

         </translation> 

         <translation name="ICD-9CM"> 

                <source value="I9C"/> 

                <target value="2.16.840.1.113883.6.2"/> 

         </translation> 

         <translation name="SNOMED"> 

                <source value="SNM"/> 

                <target value="2.16.840.1.113883.6.5"/> 

         </translation> 

         <elseCase type="keepValue"/>  

         <inverseElseCase type="keepValue"/> 

    </domain> 

</VocabularyMapping> 

Adding Functions to the Function Library 
The function library provides a list of system defined functions that facilitate the data 
transformation requirement. Functions are grouped by its functional categories (for example, 
math group, string group, etc). It is required that each group has to have a unique name 
across the whole function library, but the name of individual function is only required to be 
unique within its defined group.  

The design of function library encompasses some extensibility on the support of user-
customized functions in the definition of the function library's xml schema. In this version of 
release, no GUI utility is available to allow you to register custom function libraries to the 
mapping tool. However, advanced software engineers can update the function library 
definition file, named core.fls, located in the {home directory}\etc directory, to 
register or replace your own function implementations. After registration, the configuration 
engineer needs to make sure the corresponding customized Java library is available on the 
classpath, so that next time the mapping tool starts, it can secure the needed Java 
implementation classes during the generation of HL7 v3 messages. 
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Chapter 9 Using the caAdapter APIs 

This chapter describes the set of primary caAdapter APIs.  

Topics in this chapter include: 

• caAdapter Directory Structure on this page 
• caAdapter APIs on page 117 
• caAdapter API Error Logs on page 120 

caAdapter Directory Structure 
Depending on the type of distribution of caAdapter, the directory structure will vary. 
Table 9-1contains the directories under your {home directory}for the binary 
distribution. 

Directory Contents 

conf Component level configuration 

docs Javadocs and other useful information 

lib Java libraries and dependencies; and the MIF.zip file 

schema HL7 v3 Schema files 

workingspace Default directory where you can save project files. It contains 
log files and HL7 v3 xml instances. It also contains an 
examples directory with example data (see Appendix A 
caAdapter Example Data).  

Table 9-1 Directory Structure for caAdapter (Binary Distribution) 

Table 9-2 contains the directories under your {home directory} for source 
distribution. 

Directory Contents 

components Different caAdapter components. Each component has its own 
build script, required libraries, and configurations. caAdapter 
has common, hl7, RDS, UI, and web service components. 

conf Component level configuration 

docs Javadocs and other useful information 
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Directory Contents 

lib Java libraries and dependencies; and the MIF.zip file 

etc Important supplementary files 

workingspace Default directory where you can save project files. It contains 
log files and HL7 v3 xml instances. It also contains an 
examples directory with example data (see Appendix A 
caAdapter Example Data).  

Table 9-2 Directory Structure for caAdapter (Source Distribution) 

caAdapter APIs 
There are four primary modules in the set of caAdapter APIs. 

• Meta Data Loader 

• Transformation Service 

• HL7 v2 to HL v3 Transformation 

• Vocabulary and MIF schema Validation 

The following sections provide a description of each. 

Meta Data Loader 

HL7 provides the following format for specifying message metadata (structure, format, 
and constraints): 

• Model Interchange Format (MIF. MIF is xml based. When the message is being parsed, 
the Meta Data Loader drives how the internal HL7 message instance is built. 

 
Note: The Meta Data Loader supports both format types: a java object of the serialized MIF 
file, an xml based file. The following example demonstrates how to use the Meta Data 
Loader.    
1. Load Serialized MIF file from resource.zip - located at lib directory. 

InputStream is = this.getClass() 

.getResourceAsStream("/mif/" + mifFileName); 

  ObjectInputStream ois = new ObjectInputStream(is); 

  MIFClass mifClass = (MIFClass)ois.readObject(); 

  ois.close(); 

  is.close(); 

2. Load Serialized MIF file from an xml file. 
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  XmlToMIFImporter xmlToMIFImporter = new XmlToMIFImporter();  

        MIFClass mifClass = xmlToMIFImporter 

.importMifFromXml(new File(filepath)); 

Transformation Service 

The transformation service reads the mapping file and converts a compliant source file 
into a series of HL7 v3 xml instances. The mapping file contains a reference to the 
source specification, target specification, function library specification, and mapping 
information. 

The transformation service classes are located in the  
gov.nih.nci.caadapter.hl7.transformation package. 

The following example demonstrates how to use the transformation service. Given the 
CSV source file and the mapping file, the TransformationService class transforms 
the CSV file into the MapGenerateResult class, which contains the generated HL7 v3 
message text and the corresponding validation results. 

TransformationService ts = new TransformationService 

("data/Transformation/COCT_MT010000_MAP1-1.map", 

  "data/Transformation/COCT_MT01000_Person.CSV"); 

         

List<XMLElement> xmlElements = ts.process(); 

  if (xmlElements==null) 

{ 

   //if failed in processing the source data 

   //file,it returns error messages   

   ValidatorResults rs=ts.getValidatorResults(); 

   String errorMsg= rs.getAllMessages().toString(); 

               } 

  else  { 

//return a  list of generated messages  

for(XMLElement rootElement: xmlElements) { 

                  String hl7MessageXml= rootElement. toXML().  

                     toString(); 

     } 

HL7 v2 to HL7 V3 Transformation 

The first step in mapping an HL7 v2 to an HL7 v3 is to create a CSV specification file, or 
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an scs file, equivalent to the HL7 v2 message structure. The user can then use the 
caAdapter GUI to transform the HL7 v2 message into a CSV file based on the CSV 
specification file created in this step. The second step is to map the elements of the CSV 
file to the appropriate HL7 v3 message. These steps have been described in previous 
chapters. 

Alternatively, the user may use caAdapter’s APIs to automatically transform the HL7 v2 
data to create the corresponding CSV file (reference the second part of the first step 
above). 

Following is a sample code that shows how to accomplish this task.   

V2Converter con = new V2Converter(FileUtil.getV2DataDirPath()); 

con.convertV2ToCSV(hl7FileName, csvFileName, scsFileName); 

if (!con.isCSVValid())  

   List<String> errList = con.getValidationMessages(); 

This sample code must be caught by the  HL7MessageTreeException. 

Vocabulary and MIF Schema Validation  

Vocabulary validation provides the ability to validate HL7 structural attributes against the 
HL7 published vocabulary. MIF schema validation validates an xml format HL7 message 
against a MIF schema file provided by the user (calling program). 

The following example demonstrates how to invoke the two validation processes: 
ValidatorResults validatorsToShow=new ValidatorResults(); 
String level=CaadapterUtil.readPrefParams( 
Config.CAADAPTER_COMPONENT_HL7_TRANSFORMATION_VALIDATION_LEVEL); 
//always process the structure validation ... level_0 
validatorsToShow.addValidatorResults(xmlMsg.getValidatorResults()); 
if(level!=null&&! level.equals( 
CaAdapterPref.VALIDATION_PERFORMANCE_LEVLE_0)) 
{ 
 //add vocabulary validation ... level_1 
 validatorsToShow.addValidatorResults(xmlMsg.validate()); 
 if(level.equals(CaAdapterPref.VALIDATION_PERFORMANCE_LEVLE_2)) 
 { //add xsd validation 
 try { 
String xsdFile= FileUtil.searchMessageTypeSchemaFileName( 
xmlMsg.getMessageType(),"xsd"); 
  HL7V3MessageValidator h7v3Validator=new HL7V3MessageValidator(); 
 //add xsd validation ... level_2 
 validatorsToShow.addValidatorResults(h7v3Validator.validate(xmlMsg.to
XML().toString(), xsdFile); 
 } catch (Exception e)  
 { 
   e.printStackTrace(); 
 } 
} 
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caAdapter API Error Logs 
Many of the targets provide logging information that is printed to the console and saved to a 
file. The log files can be found in the {home directory}\workingspace directory. All 
log messages are saved to the file caadapter.log.# where # is the number of the log file 
created. 

The logging utility is configurable; edit the {home directory}\logging.properties file 
to change your logging properties. 
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Chapter 10  caAdapter Web Services Transformation 

Module 

This chapter contains information on using caAdapter’s Web Services. 

Topics in this chapter include: 

• Introduction on this page 
• Setup Mapping Scenarios Through the Web Portal on page 124 
• Programmatic Access to the caAdapter Web Services on page 125 

Introduction 
A Web service is a software application identified by a URI, whose interface and bindings 
are capable of being identified, described and discovered by xml artifacts. The web service 
also supports direct interactions with other software applications using xml based messages 
via Internet-based protocols (by World Wide Web Consortium). 

caAdapter’s CSV to HL7 v3 Message Transformation Service API is a JAVA API and can 
only be directly integrated with a JAVA-based application. This web service provides a 
powerful mechanism to integrate caAdapter’s CSV to HL7 v3 Transformation Service into a 
variety of systems that are developed under different platforms and software environment.  

caAdapter 4.0 Web Service Model includes the following two sub-components: 

• Web Portal – provides basic mapping scenario management. 

• Web Service API – provides CSV to HL7 v3 transformation service. 

The Web Portal provide a mechanism to upload all the mapping files including the actual .map 
file, CSV specification file, and HL7 v3 specification file. Once uploaded, the files can be used by 
subsequent transformation services. This is typically a one time effort. 

Figure 10-1 illustrates the Web Service Module architecture. 
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Figure 10-1 caAdapter Web Service Module Architecture 

Setup Mapping Scenarios Through the Web Portal 
This section contains the step-by-step instructions to upload mapping, CSV, and HL7 v3 
specification. 

1. Open an IE/Firefox browser and enter the following link:  
http://caadapter.nci.nih.gov 

 

Figure 10-2 caAdapter Portal 
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2. In the “Mapping Scenario Name” field, specify the name for the set of mapping files you 
are going to upload, and use this name in the later web services clients. 

3. In the “Mapping file” field, specify the name and path to the mapping file, usually with .map 
suffix. 

4. In the “scs file” field, specify the name and path to the CSV specification file, usually with 
.scs suffix. 

5. In the “H3S file” field, specify the name and path to the HL7 v3 metadata file, usually with 
.h3s suffix. 

 
Once the mapping scenario is created successfully, a confirmation message displays 
(Figure 10-3). 

 

Figure 10-3 Confirmation Message 

Programmatic Access to the caAdapter Web Services 
There are a few ways to access the caAdapter Web Services which will be explained in the 
following subsection. 

Axis 1.x RPC Style Access to caAdapter Web Services 

1. Download Axis 1.x (axis-bin-1_4.zip) from the following URL: 
http://www.apache.org/dyn/closer.cgi/ws/axis/1_4 

2. Unzip the axis-bin-1_4.zip  
3. Add the following files for the axis-1_4/lib directory to you classpath. 

a. axis.jar 
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b. axis-ant.jar 
c. commons-discovery-0.2.jar 
d. commons-logging-1.0.4.jar 
e. jaxrpc.jar 
f. log4j-1.2.8.jar 
g. saaj.jar 
h. wsdl4j-1.5.1.jar 

4. Run the following command to generate all the stubs: 
java org.apache.axis.wsdl.WSDL2Java 
http://caadapter.nci.nih.gov/caAdapterWS/ws/caAdapterTransformationService?wsdl 

5. Use the following code to access the caAdapter Web Services 
import java.util.*; 

import 
gov.nih.nci.caadapter.caAdapterWS.ws.caAdapterTransformationService.*; 

public class AxisRPCClient { 

  public static void main(String[] args) { 

    try { 

      String csvString = "ORGS,RAD\nORGID,2.1 ... ..."; 

 

 CaAdapterTransformationServiceService service  

= new CaAdapterTransformationServiceServiceLocator(); 

 CaAdapterTransformationService caAdapterService  

= service.getcaAdapterTransformationService(); 

 Object[] res  = (Object[])caAdapterService.transformationService( 

" My_WS_Scenario",csvString); 

           for(int i=0;i<res.length;i++) 

            System.out.println((String)res[i]); 

     }catch(Exception e) { 

        e.printStackTrace(); 

   } 

 } 

Axis 1.x DII Style Access to caAdapter Web Services 

1. Download Axis 1.x (axis-bin-1_4.zip) from the following URL: 
http://www.apache.org/dyn/closer.cgi/ws/axis/1_4 
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2. Unzip the axis-bin-1_4.zip  
3. Add the following files for the axis-1_4/lib directory to you classpath. 

a. axis.jar 
b. axis-ant.jar 
c. commons-discovery-0.2.jar 
d. commons-logging-1.0.4.jar 
e. jaxrpc.jar 
f. log4j-1.2.8.jar 
g. saaj.jar 
h. wsdl4j-1.5.1.jar 

4. Use the following code to access the caAdapter web services 
import org.apache.axis.client.Call; 

import org.apache.axis.client.Service; 

import org.apache.axis.encoding.XMLType; 

import javax.xml.rpc.ParameterMode; 

import javax.xml.namespace.QName; 

import org.apache.axis.utils.Options; 

import java.util.*; 

 

public class AxisClient { 

 

  public static void main(String[] args) { 

    try { 

      String endpointURL = " 
http://caadapter.nci.nih.gov/caAdapterWS/ws/caAdapterTransformationServ
ice"; 

      String methodName = "transformationService"; 

      String csvString = "ORGS,RAD\nORGID,2.1 ... ..."; 

      Service service = new Service(); 

      Call call = (Call)service.createCall(); 

      call.setTargetEndpointAddress(new java.net.URL(endpointURL)); 

      call.setOperationName(methodName); 

      call.addParameter("parameter_name",  

XMLType.XSD_STRING,  
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ParameterMode.IN ); 

      call.addParameter("csvstringname",  

       XMLType.XSD_STRING,  

 ParameterMode.IN ); 

      call.setReturnClass(java.util.ArrayList.class); 

      ArrayList res = (ArrayList)call.invoke( 

new Object[]{"My_WS_Scenario",csvString}); 

      System.out.println(res); 

    }catch(Exception e) { 

       e.printStackTrace(); 

    } 

 } 

In the above code, “My_WS_Scenario" is the “Mapping Scenario Name” you used in the 
caAdapter Web Service Management Portal. CSV String is the actual data that needs to be 
transformed. The result is an xml message of the result HL7 v3 messages. 

Axis 2.0 RPC Style Access to caAdapter Web Services 

1. Download Axis 2.0 (axis2-1.1.zip) from the following URL: http://ws.apache.org/axis2/ 
2. Unzip the axis2-1.1.zip  
3. Add the following files for the axis-1_4/lib directory to you classpath. 

a. axis.jar 
b. axis-ant.jar 
c. commons-discovery-0.2.jar 
d. commons-logging-1.0.4.jar 
e. jaxrpc.jar 
f. log4j-1.2.8.jar 
g. saaj.jar 
h. wsdl4j-1.5.1.jar 

4. Use the following code to access the caAdapter Web Services 
 package swe645; 

import java.util.ArrayList; 

import javax.xml.namespace.QName; 

import org.apache.axis2.AxisFault; 

import org.apache.axis2.addressing.EndpointReference; 

import org.apache.axis2.client.Options; 
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import org.apache.axis2.rpc.client.RPCServiceClient; 

import org.apache.axiom.om.impl.llom.OMTextImpl; 

import org.apache.axiom.om.impl.llom.OMElementImpl 

 

public class AxisClient { 

 

   public static void main(String[] args1) throws AxisFault { 

      String csvString = "ORGS,RAD\nORGID,2.1 ... ..."; 

 

  RPCServiceClient serviceClient = new RPCServiceClient(); 

        Options options = serviceClient.getOptions(); 

        EndpointReference targetEPR = new EndpointReference(" 
http://caadapter.nci.nih.gov/caAdapterWS/ws/caAdapterTransformationServ
ice"); 

        options.setTo(targetEPR); 

        // QName of the target method  

        QName opAddEntry = new QName("caAdapter", "transformationService"); 

        Object[] opAddEntryArgs = new Object[] {  

"My_WS_Scenario", 

csvString }; 

        Class[] returnTypes = new Class[] { ArrayList.class }; 

        // Invoking the method 

        Object[] res = serviceClient.invokeBlocking(opAddEntry, 

          opAddEntryArgs, returnTypes); 

         

        ArrayList resultArrayList = (ArrayList) res[0]; 

  for(int i=0;i< resultArrayList.size();i++) { 

   OMElementImpl omE = (OMElementImpl)resultArrayList.get(i); 

     OMTextImpl textOM = (OMTextImpl)omE.getFirstOMChild(); 

     System.out.println(textOM.getText()); 

   } 

    } 

} 
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Chapter 11  caAdapter File Types 

This chapter includes the different file types and their formats used by caAdapter.  

Topics in this chapter include: 

• caAdapter File Formats and Locations on this page 
• CSV Data File on page 132 
• CSV Specification on page 132 
• HL7 v3 Specification on page 134 
• HL7 v2 Specifications on page 139 
• SDTM Data Files on page 142 
• SDTM Meta Data Files on page 143 
• Function Specification on page 144 
• HL7 v3 Message on page 146 
• Object to Database Map Specification on page 149 

caAdapter File Formats and Locations 
caAdapter uses a variety of files in its APIs and mapping tool. Table 11-1 contains the files 
and extensions used by caAdapter. 

File Type Extension 

CSV Specification .scs 

HL7 v3 Specification .h3s and .xml 

HL7 v2 Message Structure .dat 

HL7 v3 DataTypeSpec .dat 

HL7 v3 Segment Attribute Table .dat 

HL7 v3 Definition Table .dat 

Function Library Specification .fls 

SDTM Data File .txt 

SDTM Metadata File .xml 

Map Specification .map 

HL7 v3 Message .xml 

Table 11-1 File extensions 
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Note: Manual editing of those files is not supported and is highly discouraged. 

Warning! The map specification has an internal reference to the full path name of the source and 
target specification files. This must be accurate in order to process the conversion or to edit a 
map specification successfully. Though it is not recommended, the map specification file can be 
manually edited to change the file path for the source and target specification if necessary. If you 
are sharing map specification files with other users, you must send all three files, the CSV 
Specification (.scs), HL7 v3 Specification (.h3s, or .xml), and map specification (.map) and 
not just the map specification. 

CSV Data File  
It is an assumption for this version of the mapping tool that the source data systems provide data 
in CSV flat file formats with the following characteristics: 

• File contents are organized into multi-line logical records. 

• Each line, called a segment, begins with an identifier, called a segment name, and is 
terminated by a new-line character. 

• Each segment has one or more data items, called fields, which follow the segment name 
and terminates by commas (except for the last field on the line that uses the segment 
terminator). 

• Segments may occur more than once in the same logical record, except for the first, or 
root, segment, which always indicates the beginning of a new record. 

• Segments are related to one another in a parent-child hierarchy that documents the one-
to-many nature of the association between related data items. 

• A CSV file may have one or more logical records. Each of these is terminated by the 
beginning of the next record (a new root segment) or the end of file. 

• The intention is that each logical record will become one single HL7 v3 xml message 
instance. 

CSV Specification  
CSV specification describes the structure of a CSV instance. In essence, it is a CSV 
specification in the same way an XSD is a specification of an xml instance. The CSV 
specification is based on common concepts found in EDI, CSV and HL7 v2-related files. To 
document this structure, the CSV specification uses an xml format that has three main 
elements: 

1. <csvMetadata> 
2. <segment> 
3. <field>  
 
There can only be one root <segment>, but within it there can be any number of dependent 
<segment> elements and any number of <field> elements. All <field> elements have a column 
number assigned which corresponds to the second, third, etc., column in the CSV file (the first is 
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the segment name which is considered column 1). The field names are informational and are not 
used in the mapping file; only the segment name and column number are referenced.  

Following is a CSV specification file (090102.scs) example. 

<?xml version="1.0" encoding="UTF-8"?> 

<csvMetadata xmlPath="csvMetaData" version="1.2"> 

   <segment name="ORGS" xmlPath="ORGS" cardinality="1..1"> 

      <segment name="ORGID" xmlPath="ORGS.ORGID" cardinality="0..*"> 

         <field column="1" name="Root" datatype="String" 
xmlPath="ORGS.ORGID.Root"/> 

         <field column="2" name="Extension" datatype="String" 
xmlPath="ORGS.ORGID.Extension"/> 

      </segment> 

      <segment name="ORGNM" xmlPath="ORGS.ORGNM" cardinality="0..*"> 

         <field column="1" name="Name" datatype="String" 
xmlPath="ORGS.ORGNM.Name"/> 

      </segment> 

      <segment name="ORGAD" xmlPath="ORGS.ORGAD" cardinality="0..*"> 

         <field column="1" name="Street_1" datatype="String" 
xmlPath="ORGS.ORGAD.Street_1"/> 

         <field column="2" name="Street_2" datatype="String" 
xmlPath="ORGS.ORGAD.Street_2"/> 

         <field column="3" name="City" datatype="String" 
xmlPath="ORGS.ORGAD.City"/> 

         <field column="4" name="State" datatype="String" 
xmlPath="ORGS.ORGAD.State"/> 

         <field column="5" name="Zip_Code" datatype="String" 
xmlPath="ORGS.ORGAD.Zip_Code"/> 

      </segment> 

      <segment name="PERSNM" xmlPath="ORGS.PERSNM" cardinality="0..*"> 

         <field column="1" name="First_Name" datatype="String" 
xmlPath="ORGS.PERSNM.First_Name"/> 

         <field column="2" name="Last_Name" datatype="String" 
xmlPath="ORGS.PERSNM.Last_Name"/> 

         <field column="3" name="Middle_Initial" datatype="String" 
xmlPath="ORGS.PERSNM.Middle_Initial"/> 
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         <field column="4" name="Job_Code" datatype="String" 
xmlPath="ORGS.PERSNM.Job_Code"/> 

      </segment> 

      <segment name="PERSID" xmlPath="ORGS.PERSID" cardinality="0..*"> 

         <field column="1" name="Root" datatype="String" 
xmlPath="ORGS.PERSID.Root"/> 

         <field column="2" name="Extension" datatype="String" 
xmlPath="ORGS.PERSID.Extension"/> 

      </segment> 

      <segment name="PERSAD" xmlPath="ORGS.PERSAD" cardinality="0..*"> 

         <field column="1" name="Street_1" datatype="String" 
xmlPath="ORGS.PERSAD.Street_1"/> 

         <field column="2" name="Street_2" datatype="String" 
xmlPath="ORGS.PERSAD.Street_2"/> 

         <field column="3" name="City" datatype="String" 
xmlPath="ORGS.PERSAD.City"/> 

         <field column="4" name="State" datatype="String" 
xmlPath="ORGS.PERSAD.State"/> 

         <field column="5" name="Zip_Code" datatype="String" 
xmlPath="ORGS.PERSAD.Zip_Code"/> 

      </segment> 

      <field column="1" name="ORG_CODE" datatype="String" 
xmlPath="ORGS.ORG_CODE"/> 

   </segment> 

</csvMetadata> 

HL7 v3 Specifications 
The HL7 v3 specification, used to define the HL7 v3 metadata information, is based largely 
on the MIF for the target HL7 v3 message. An HL7 V3 specification may be saved either as 
a binary .h3s file or as an .xml file. The .h3s file is not readable. The .xml file uses four main 
types of nested elements:   

• < class>  

• < association> 

• <attribute> 

• < type> 

• < dataField>  

Following is part of an HL7 v3 specification file (150003.h3s) example. See the {home 
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directory}\workingspace\examples\150003 for the entire file. 

<class name="ContactParty" isEnabled="true" title="MIF Clone 
Properties" referenceName="" sortKey=""> 

 <packageLocation /> 

 <attribute name="classCode" type="CS" defaultValue="CON" 
isEnabled="true" title="MIF Attribute Properties" mnemonic="CON" 
sortKey="1" minimumMultiplicity="1" isStrutural="true" 
parentXmlPath="Organization.contactParty00" maximumMultiplicity="1" 
isMandatory="true" conformance="R" dDefaultValueProperty="CON" 
dDomainNameOidProperty="RoleClassContact (2.16.840.1.113883.11.12205)" 
codingStrength="CNE" multiplicityIndex="0" minimumSupportedLength="0" 
domainName="RoleClassContact" /> 

 <attribute name="id" type="II" isEnabled="true" title="MIF Attribute 
Properties" sortKey="2" minimumMultiplicity="0" 
parentXmlPath="Organization.contactParty00" maximumMultiplicity="-1" 
multiplicityIndex="0" minimumSupportedLength="0"> 

   <type name="II" isEnabled="true" parents="ANY"> 

  <dataField name="nullFlavor" type="NullFlavor" max="-2" 
isValid="true" title="MIF Data Field Properties" isSimple="true" 
parentXmlPath="Organization.contactParty00.id00" min="-2" 
isOptional="true" isAttribute="true" /> 

  <dataField name="assigningAuthorityName" type="st" max="-2" 
isValid="true" isEnabled="true" title="MIF Data Field Properties" 
isSimple="true" parentXmlPath="Organization.contactParty00.id00" min="-
2" isOptional="true" isAttribute="true" /> 

  ... ... 

   </type> 

 </attribute> 

 <attribute name="addr" type="AD" isEnabled="true" title="MIF 
Attribute Properties" sortKey="4" minimumMultiplicity="0" 
parentXmlPath="Organization.contactParty00" maximumMultiplicity="-1" 
multiplicityIndex="0" minimumSupportedLength="0"> 

   <type name="AD" isEnabled="true" parents="ANY"> 

  <dataField name="direction" type="adxp.direction" max="-2" 
isValid="true" title="MIF Data Field Properties" min="-2" /> 
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  <dataField name="city" type="adxp.city" max="-2" isValid="true" 
isEnabled="true" title="MIF Data Field Properties" 
isOptionChosen="true" 
parentXmlPath="Organization.contactParty00.addr00" min="-2"> 

    <type name="adxp.city" isEnabled="true" parents="ADXP"> 

   <dataField name="reference" type="TEL" max="0" title="MIF Data 
Field Properties" min="0" /> 

   <dataField name="mediaType" type="cs" max="-2" isValid="true" 
isEnabled="true" title="MIF Data Field Properties" isSimple="true" 
parentXmlPath="Organization.contactParty00.addr00.city" min="-2" 
isAttribute="true" /> 

   ... ... 

    </type> 

  </dataField> 

  <dataField name="streetNameBase" type="adxp.streetNameBase" 
max="-2" isValid="true" title="MIF Data Field Properties" min="-2" /> 

  <dataField name="precinct" type="adxp.precinct" max="-2" 
isValid="true" title="MIF Data Field Properties" min="-2" /> 

  <dataField name="unitType" type="adxp.unitType" max="-2" 
isValid="true" title="MIF Data Field Properties" min="-2" /> 

  ... ... 

 </attribute>   

 <association name="contactPerson" isEnabled="true" title="MIF 
Association Properties" sortKey="1" minimumMultiplicity="0" 
isOptionChosen="true" parentXmlPath="Organization.contactParty00" 
maximumMultiplicity="1" multiplicityIndex="0"> 

  <class name="Person" isEnabled="true" title="MIF Clone 
Properties" referenceName="" sortKey=""> 

   <packageLocation /> 

   <attribute name="classCode" type="CS" isEnabled="true" 
title="MIF Attribute Properties" mnemonic="PSN" sortKey="1" 
minimumMultiplicity="1" isStrutural="true" 
parentXmlPath="Organization.contactParty00.contactPerson" 
maximumMultiplicity="1" isMandatory="true" conformance="R" 
dDefaultValueProperty="PSN" dDomainNameOidProperty="EntityClass 
(2.16.840.1.113883.11.10882)" codingStrength="CNE" 
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multiplicityIndex="0" fixedValue="PSN" minimumSupportedLength="0" 
domainName="EntityClass" /> 

   <attribute name="determinerCode" type="CS" isEnabled="true" 
title="MIF Attribute Properties" mnemonic="INSTANCE" sortKey="2" 
minimumMultiplicity="1" isStrutural="true" 
parentXmlPath="Organization.contactParty00.contactPerson" 
maximumMultiplicity="1" isMandatory="true" conformance="R" 
dDefaultValueProperty="INSTANCE" 
dDomainNameOidProperty="EntityDeterminer (2.16.840.1.113883.11.10878)" 
codingStrength="CNE" multiplicityIndex="0" fixedValue="INSTANCE" 
minimumSupportedLength="0" domainName="EntityDeterminer" /> 

   <attribute name="name" type="EN" isEnabled="true" title="MIF 
Attribute Properties" sortKey="3" minimumMultiplicity="1" 
parentXmlPath="Organization.contactParty00.contactPerson" 
maximumMultiplicity="-1" conformance="R" multiplicityIndex="0" 
minimumSupportedLength="0"> 

   <type name="EN" isEnabled="true" parents="ANY"> 

     <dataField name="suffix" type="en.suffix" max="-2" 
isValid="true" isEnabled="true" title="MIF Data Field Properties" 
isOptionChosen="true" 
parentXmlPath="Organization.contactParty00.contactPerson.name00" min="-
2"> 

    <type name="en.suffix" isEnabled="true" parents="ENXP"> 

      <dataField name="mediaType" type="cs" max="-2" 
isValid="true" isEnabled="true" title="MIF Data Field Properties" 
isSimple="true" 
parentXmlPath="Organization.contactParty00.contactPerson.name00.suffix" 
min="-2" isAttribute="true" /> 

      <dataField name="representation" 
type="BinaryDataEncoding" max="-2" isValid="true" isEnabled="true" 
title="MIF Data Field Properties" isSimple="true" 
parentXmlPath="Organization.contactParty00.contactPerson.name00.suffix" 
min="-2" isAttribute="true" /> 

      <dataField name="integrityCheckAlgorithm" 
type="IntegrityCheckAlgorithm" max="-2" isEnabled="true" title="MIF 
Data Field Properties" isProhibited="true" isSimple="true" min="-2" 
isAttribute="true" /> 

      <dataField name="language" type="cs" max="-2" 
isValid="true" isEnabled="true" title="MIF Data Field Properties" 
isSimple="true" 
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parentXmlPath="Organization.contactParty00.contactPerson.name00.suffix" 
min="-2" isOptional="true" isAttribute="true" /> 

      <dataField name="thumbnail" type="ED" max="0" title="MIF 
Data Field Properties" min="0" /> 

      <dataField name="compression" type="CompressionAlgorithm" 
max="-2" isEnabled="true" title="MIF Data Field Properties" 
isProhibited="true" isSimple="true" min="-2" isAttribute="true" /> 

      <dataField name="nullFlavor" type="NullFlavor" max="-2" 
isValid="true" isEnabled="true" title="MIF Data Field Properties" 
isSimple="true" 
parentXmlPath="Organization.contactParty00.contactPerson.name00.suffix" 
min="-2" isOptional="true" isAttribute="true" /> 

      <dataField name="partType" type="EntityNamePartType" 
max="-2" isValid="true" isEnabled="true" title="MIF Data Field 
Properties" isSimple="true" 
parentXmlPath="Organization.contactParty00.contactPerson.name00.suffix" 
min="-2" isAttribute="true" /> 

      <dataField name="integrityCheck" type="bin" max="-2" 
isEnabled="true" title="MIF Data Field Properties" isProhibited="true" 
isSimple="true" min="-2" isAttribute="true" /> 

      <dataField name="reference" type="TEL" max="0" title="MIF 
Data Field Properties" min="0" /> 

      <dataField name="qualifier" 
type="set_EntityNamePartQualifier" max="-2" isValid="true" 
isEnabled="true" title="MIF Data Field Properties" isSimple="true" 
parentXmlPath="Organization.contactParty00.contactPerson.name00.suffix" 
min="-2" isOptional="true" isAttribute="true" /> 

      <dataField name="inlineText" max="1" isValid="true" 
isEnabled="true" title="MIF Data Field Properties" 
isOptionChosen="true" isSimple="true" 
parentXmlPath="Organization.contactParty00.contactPerson.name00.suffix" 
min="1" /> 

    </type> 

     </dataField> 

     <dataField name="nullFlavor" type="NullFlavor" max="-2" 
isValid="true" isEnabled="true" title="MIF Data Field Properties" 
isSimple="true" 
parentXmlPath="Organization.contactParty00.contactPerson.name00" min="-
2" isOptional="true" isAttribute="true" /> 
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     <dataField name="inlineText" max="1" isValid="true" 
isEnabled="true" title="MIF Data Field Properties" 
isOptionChosen="true" isSimple="true" 
parentXmlPath="Organization.contactParty00.contactPerson.name00" 
min="1" /> 

     <dataField name="delimiter" type="en.delimiter" max="-2" 
isValid="true" title="MIF Data Field Properties" 
parentXmlPath="Organization.contactParty00.contactPerson.name00" min="-
2" /> 

     <dataField name="validTime" type="IVL_TS" max="-2" 
isValid="true" title="MIF Data Field Properties" 
parentXmlPath="Organization.contactParty00.contactPerson.name00" 
min="0" /> 

   </type> 

   </attribute> 

  </class> 

 </association> 

 ... ... 

</class> 

HL7 v2 Specifications 
The HL7 v2 message specification is described in four kinds of resource files, i.e. Message 
Structure, DataTypeSpec, DefinitionTable, SegmentAttributeTable. caAdapter requires all 
four file collections to be able to parse HL7 v2 messages. Figure 11-1 shows the directory 
structure where the resources files are stored.  



caAdapter 4.0 User’s Guide 

140 

 

Figure 11-1 Resource Directory Structure 

Message Structure 

The Message Structure directory contains the information of the HL7 v2 message. The 
directory is organized by a collection of DAT files with file names corresponding to message 
type of the HL7 v2 message. ‘ADT_A03’ is a message type and the ‘ADT_A03.DAT’ is the 
data file. This DAT file represents the order of segments and represents the required and 
optional segments. 

  

Figure 11-2 Contents of “RTB_Z78.DAT”message structure 

DataTypeSpec 

This directory contains DAT files with the file names corresponding to the data type. For example: 
AD is a datatype for representing the address object. The corresponding file in the directory has a 
physical file with the name “AD.DAT”. The content of “AD.DAT” is shown below in Figure 11-3. 
The position, datatype (e.g. ST for String and ID for Identification), and description of each field 
are listed. 
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Figure 11-3 Contents of “AD.DAT”data type 

Segment Attribute Table 

The segment attribute table represents the structure of the Message Header (MSH) segment. It 
shows the fields, data types, positions, repeating fields, and index of each field for the MSH 
segment. Figure 11-4 shows an example of a Segment Attribute Table. 

 

Figure 11-4 Contents of “MSH.DAT”segment information 

Definition Table 

The definition table stores the HL7 v2 vocabulary information for each segment in the 
message. For example, in the 9901.DAT file, shown in Figure 11-5, ‘ABS’ segment is 
represented as ‘Abstract’ and ‘’DB1’ as ‘Disability’. 
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Figure 11-5 Contents of “9901.DAT”segment information 

SDTM Data Files  
A Study Data Tabulation Module (SDTM) text file consists of the mapped data elements from the 
CSV file. The file has a .txt extension. This text file is created by the SDTM transformation 
service. For each mapped source field in a segment in the scs file, a record will be created 
keeping the parent-child relationship intact. This is accomplished by prefixing the path information 
to each row in the CSV file. The transformation service engine will fetch values for all the fields in 
the specified path. 

For example, the converted CSV file is transformed by the transformation service as shown 
below. 

“\SourceTree\INVESTEVN\TRIGGER_5\REACTION_51\INVESTIGATIVESUBJECT_511\S

UPPLY_5112\AUTHOR_51123\ASGNDENTT090000_511231\ASSIGNEDPERSON_5112311^D

oeighty,Conrard,D.” 

The field name is ‘ASSIGNEDPERSON_5112311’ and the value is 
‘Doeighty,Conrard,D.’ but the parent segment for this particular record are as listed 
below: 
1. \SourceTree\INVESTEVN\TRIGGER_5\REACTION_51\INVESTIGATIVESUBJECT_511\SU

PPLY_5112\AUTHOR_51123\ASGNDENTT090000_511231\ASSIGNEDPERSON_5112311^Do
eighty,Conrard,D. 
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2. \SourceTree\INVESTEVN\TRIGGER_5\REACTION_51\INVESTIGATIVESUBJECT_511\SU
PPLY_5112\AUTHOR_51123\ASGNDENTT090000_511231 

3. \SourceTree\INVESTEVN\TRIGGER_5\REACTION_51\INVESTIGATIVESUBJECT_511\SU
PPLY_5112\AUTHOR_51123\ 

4. \SourceTree\INVESTEVN\TRIGGER_5\REACTION_51\INVESTIGATIVESUBJECT_511\SU
PPLY_5112\ 

5. \SourceTree\INVESTEVN\TRIGGER_5\REACTION_51\INVESTIGATIVESUBJECT_511\ 
6. \SourceTree\INVESTEVN\TRIGGER_5\REACTION_51\ 
7. \SourceTree\INVESTEVN\TRIGGER_5\ 
8. \SourceTree\INVESTEVN\ 
9. \SourceTree\ 
 
The transformation service checks for mapped fields in any of the parent segments. If a 
mapping segment exists, the corresponding value from the CSV file will be set in the same 
record in the resulting SDTM .txt file. 

 
Figure 11-6 Contents of SDTM Text File 

SDTM Meta Data Files  
SDTM metadata file, also called Case Report Tabulation Data Definition Specification 
(define.xml), describes the data exchange structure for the different domains. Sample 
define.xml can be found at CDISC web site:http://www.cdisc.org/models/def/v1.0/index.html. 
The following is a sample section of the define.xml file downloaded form CDISC. 

<?xml version="1.0" encoding="ISO-8859-1"?> 
<!-- ***************************************************************** 
--> 
<!-- File: defineexample1.xml                                                     
--> 
<!-- Date: 28-01-2005                                                               
--> 
<!-- Author: Clinical Data Interchange Standards Consortium (CDISC)             
--> 
<!-- Description: This is an example define.xml document which … the 
Case  -->  
<!--   Report Tabulation Data Definition Specification Version 1.0.0              
--> 
<!-- ***************************************************************** 
--> 
<ODM  
  xmlns="http://www.cdisc.org/ns/odm/v1.2" 
  xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
  xmlns:xlink="http://www.w3.org/1999/xlink"  
  xmlns:def="http://www.cdisc.org/ns/def/v1.0" 
  xsi:schemaLocation="http://www.cdisc.org/ns/odm/v1.2 define1-0-0.xsd"   
  FileOID="Study1234"  
  ODMVersion="1.2"  
  FileType="Snapshot"  
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  CreationDateTime="2004-07-28T12:34:13-06:00"> 
<Study OID="1234"> 
  <GlobalVariables> 
    <StudyName>1234</StudyName> 
    <StudyDescription>1234 Data Definition</StudyDescription> 
    <ProtocolName>1234</ProtocolName> 
  </GlobalVariables> 
  <MetaDataVersion OID="CDISC.SDTM.3.1.0" 

Function Specification  

Function Specification Overview 

The function specification is used as a guide for function objects to read the function 
specification and determine what objects to call to execute a function (for example, the 
concatenation function). The function specification also stores data points for rendering the 
function graphical representation within the mapping tool. It uses the following types of 
nested elements:  

1. <function> 
2. <group name> 
3. <function name> 
4. <inputs> 
5. <datapoint> 
6. <outputs> 
 
Following is an example of a function specification file (core.fls). See the {home 
directory}\map\functions directory for the entire file. 

<?xml version="1.0"?> 

<functions> 

    <group name="constant" xmlPath="constant"> 

  <function name="constant" xmlPath="constant.constant"> 

   <outputs> 

    <datapoint pos="0" name="constant" datatype="string" 
xmlPath="constant.constant.outputs.0"/> 

   </outputs> 

  </function> 

        <!--<function name="saveValue" xmlPath="e34f7420-09db-11da-
8gd4-io90d451x7h5"> 

   <inputs> 

    <datapoint pos="0" name="save" datatype="string" 
xmlPath="e35g7420-09db-11da-8ge5-io90d451x7k6"/> 
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   </inputs> 

            <outputs> 

    <datapoint pos="0" name="dummy" datatype="string" 
xmlPath="e37i7420-09db-11da-8gg9-io90d451x7m8"/> 

   </outputs> 

        </function> 

        <function name="readValue" xmlPath="e36h7420-09db-11da-8gf6-
io90d451x7l7"> 

   <outputs> 

    <datapoint pos="0" name="read" datatype="string" 
xmlPath="e37i7420-09db-11da-8gg7-io90d451x7m8"/> 

   </outputs> 

  </function> --> 

    </group> 

    <group name="date" xmlPath="date"> 

  <function name="changeFormat" xmlPath="date.changeFormat"> 

   <inputs> 

    <datapoint pos="0" name="fromFormat" datatype="string" 
xmlPath="date.changeFormat.inputs.0"/> 

    <datapoint pos="1" name="dateIn" datatype="string" 
xmlPath="date.changeFormat.inputs.1"/> 

   </inputs> 

   <outputs> 

    <datapoint pos="0" name="dateOut" datatype="string" 
xmlPath="date.changeFormat.outputs.0"/> 

   </outputs> 

   <implementation 
classname="gov.nih.nci.caadapter.common.function.DateFunction" 
method="changeFormat"/> 

  </function> 

        <function name="countDays" xmlPath="date.countDays"> 

   <inputs> 

    <datapoint pos="0" name="fromDate" datatype="string" 
xmlPath="date.countDays.inputs.0"/> 
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    <datapoint pos="1" name="toDate" datatype="string" 
xmlPath="date.countDays.inputs.1"/> 

   </inputs> 

   <outputs> 

    <datapoint pos="0" name="dayNumber" datatype="int" 
xmlPath="date.countDays.outputs.0"/> 

   </outputs> 

   <implementation 
classname="gov.nih.nci.caadapter.common.function.DateFunction" 
method="countDays"/> 

  </function> 

</group> 

… … 

</functions> 

Adding Functions to the Function Library 

The function library provides a list of system defined functions that facilitate the data 
transformation requirement. Functions are grouped by functional categories, e.g. math 
group, string group, etc. It is required that each group has a unique name across the whole 
function library, but the name of individual function is only required to be unique within its 
defined group.  

The design of the function library encompasses some extensibility to support user-
customized functions in the definition of the function library's xml schema. This version of 
caAdapter does not provide a GUI utility to allow registering custom function libraries to the 
Mapping Tool. However, advanced software engineers can update the function library 
definition file, named core.fls, located in the {home directory}\etc directory, to 
register or replace customized function implementations. After registration, the configuration 
engineer needs to make sure the corresponding customized Java library is available on the 
classpath. This insures that the mapping tool can locate the needed Java implementation 
classes during the generation of HL7 v3 messages. 

HL7 v3 Message 
The HL7 v3 message is the end goal of using caAdapter. It is represented in xml. Following 
is an example HL7 v3 message file (ExampleOutput1.xml). 

<?xml version="1.0" encoding="UTF-8" ?>  
- <COCT_MT090102.AssignedPerson xmlns="urn:hl7-org:v3" 
classCode="ASSIGNED"> 
  <id root="2.16.840.1.113883.19.1" extension="12345" />  
  <id root="2.16.840.1.113883.19.2" extension="23456" />  
  <id root="2.16.840.1.113883.19.3" extension="34567" />  
  <code code="NRS10" codeSystem="2.16.840.1.113883.19.1" />  
- <addr use="WP"> 
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  <streetAddressLine>123 Main St.Suite 500</streetAddressLine>  
  <city>Rockville</city>  
  <state>MD</state>  
  <postalCode>20852</postalCode>  
  </addr> 
- <addr> 
  <streetAddressLine>456 Washington BlvdSuite 1000</streetAddressLine>  
  <city>Washington</city>  
  <state>DC</state>  
  <postalCode>20002</postalCode>  
  </addr> 
- <assignedPerson classCode="PSN" determinerCode="INSTANCE"> 
- <name use="L"> 
  <family>Shang</family>  
  <given>Lee</given>  
  </name> 
  </assignedPerson> 
- <representedOrganization classCode="ORG" determinerCode="INSTANCE"> 
  <id root="2.16.840.1.113883.19.4" extension="1111GHHMO" />  
  <id root="2.16.840.1.113883.19.5" extension="2222" />  
  <name>Good Health HMO</name>  
  <name>Good Health Radiology</name>  
  <name>GHHMOR</name>  
- <addr use="WP"> 
  <streetAddressLine>456 Washington BlvdSuite 1000</streetAddressLine>  
  <city>Washington</city>  
  <state>DC</state>  
  <postalCode>20002</postalCode>  
  </addr> 
- <addr> 
  <streetAddressLine>567 Empire Ave.Suite 10000</streetAddressLine>  
  <city>New York</city>  
  <state>NY</state>  
  <postalCode>10118</postalCode>  
  </addr> 
  </representedOrganization> 
  </COCT_MT090102.AssignedPerson> 

 

CSV to HL7 v3 Map Specification 
A CSV to HL7 v3 map specification describes the relationship between components via links 
and/or views. It has the following main elements: 

1. <components> 
2. <links> 

3. <source> 

4. <target> 

5. <linkpointer> 

6. <views> 
 
A component is a reference to a resource that exists in the system prior to the mapping. A 
function component is an algorithm between two (or more) pieces of data. 
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Following is a part of a map specification file (150003.map) example. See the {home 
directory}\workingspace\examples\150003 for the entire file. 

<?xml version="1.0" encoding="UTF-8"?> 

<mapping version="1.2"> 

   <components> 

      <component kind="scs" location="150003.scs" type="source"/> 

      <component kind="h3s" location="150003.h3s" type="target"/> 

   </components> 

   <links> 

      <link> 

         <source> 

            <linkpointer kind="scs" xmlPath="ORGS.ORG_CODE"/> 

         </source> 

         <target> 

            <linkpointer kind="h3s" 
xmlPath="Organization.contactParty00.contactPerson.name00.inlineText"/> 

         </target> 

      </link> 

      <link> 

         <source> 

            <linkpointer kind="scs" xmlPath="ORGS.ORGID.Root"/> 

         </source> 

         <target> 

            <linkpointer kind="h3s" 
xmlPath="Organization.contactParty00.id00.extension"/> 

         </target> 

      </link> 

      <link> 

         <source> 

            <linkpointer kind="scs" xmlPath="ORGS.ORGID"/> 

         </source> 

         <target> 

            <linkpointer kind="h3s" 
xmlPath="Organization.contactParty00"/> 

         </target> 

      </link> 

   </links> 

   <views> 
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      <view component-id="source.scs.0" height="0" width="0" x="0" 
y="0"/> 

      <view component-id="target.h3s.0" height="0" width="0" x="0" 
y="0"/> 

   </views> 

</mapping> 

Object to Database Map Specification 
An object to database map specification describes the relationship between 
objects/attributes and database tables/columns via links. It has the following main elements: 

1. <components> 

2. <links> 
 
A component is a reference to an xmi file that exists in the system prior to the mapping. The 
location attribute of the component specifies the exact name and location of that xmi file. 

A link describes a mapping for an object, an attribute or an association. A link element has a 
type and datatype attribute. 

If the type value is “dependency “, the <source> sub-element describes an object to be 
mapped, and the <target> sub-element describes the target table that will be mapped to. 

  <link type="dependency" parent="null"> 

    <source>Logical View.Logical 
Model.gov.nih.nci.cabio.domain.Gene</source> 

    <target>Logical View.Data Model.GENE</target> 

  </link> 

If the type value is “attribute “, the <source> sub-element describes an attribute to be 
mapped, and the <target> sub-element describes the target table column that will be 
mapped to. 

  <link type="attribute" datatype="String"> 

    <source>Logical View.Logical 
Model.gov.nih.nci.cabio.domain.Gene.locusLinkSummary</source> 

    <target>Logical View.Data Model.GENE.LOCUS_LINK_SUMMARY</target> 

  </link> 

If type value is “association “, this section describes the one-to-one or one-to-many 
association, the <source> sub-element describes an association attribute to be mapped, 
and the <target> sub-element describes the target foreign key column that will be mapped 
to. 

  <link type="association"> 

    <source>Logical View.Logical 
Model.gov.nih.nci.cabio.domain.Gene.chromosome</source> 
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    <target>Logical View.Data Model.GENE.CHROMOSOME_ID</target> 

  </link> 

If the type value is “manytomany “, the section describes the many-to-many association. The 
<source> sub-element describes an association attribute to be mapped, and the <target> 
sub-element describes the target foreign key column that will be mapped to. 

  <link type="manytomany"> 

    <source>Logical View.Logical 
Model.gov.nih.nci.cabio.domain.Sequence.geneCollection</source> 

    <target>Logical View.Data Model.GENE_SEQUENCE.GENE_ID</target> 

  </link> 

Following is a part of a map specification file (example.map) example. See the {home 
directory}\workingspace\examples\Object-2-DB-Example for the entire file. 

<?xml version="1.0" encoding="UTF-8"?> 

<mappings type="sdkintegration"> 

  <components> 

    <component location="D:\projects\hl7sdk-
new\workingspace\sample.xmi" /> 

    <component location="D:\projects\hl7sdk-
new\workingspace\sample.xmi" /> 

  </components> 

  <link type="dependency" parent="null"> 

    <source>Logical View.Logical 
Model.gov.nih.nci.cabio.domain.Gene</source> 

    <target>Logical View.Data Model.GENE</target> 

  </link> 

  <link type="dependency" parent="null"> 

    <source>Logical View.Logical 
Model.gov.nih.nci.cabio.domain.Taxon</source> 

    <target>Logical View.Data Model.TAXON</target> 

  </link> 

    … … 

  <link type="attribute" datatype="String"> 

    <source>Logical View.Logical 
Model.gov.nih.nci.cabio.domain.Gene.locusLinkSummary</source> 

    <target>Logical View.Data Model.GENE.LOCUS_LINK_SUMMARY</target> 
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  </link> 

  <link type="attribute" datatype="String"> 

    <source>Logical View.Logical 
Model.gov.nih.nci.cabio.domain.Gene.OMIMID</source> 

    <target>Logical View.Data Model.GENE.OMIM_ID</target> 

  </link> 

…… 

 

  <link type="association"> 

    <source>Logical View.Logical 
Model.gov.nih.nci.cabio.domain.Gene.taxon</source> 

    <target>Logical View.Data Model.GENE.TAXON_ID</target> 

  </link> 

  <link type="association"> 

    <source>Logical View.Logical 
Model.gov.nih.nci.cabio.domain.Gene.chromosome</source> 

    <target>Logical View.Data Model.GENE.CHROMOSOME_ID</target> 

  </link> 

  <link type="manytomany"> 

    <source>Logical View.Logical 
Model.gov.nih.nci.cabio.domain.Sequence.geneCollection</source> 

    <target>Logical View.Data Model.GENE_SEQUENCE.GENE_ID</target> 

  </link> 

  <link type="manytomany"> 

    <source>Logical View.Logical 
Model.gov.nih.nci.cabio.domain.Gene.libraryCollection</source> 

    <target>Logical View.Data Model.LIBRARY_GENE.LIBRARY_ID</target> 

  </link> 

… … 

</mappings> 

This version of caAdapter, although still supports the map file, it no longer requires it. All 
mapping specifications are now stored in the xmi file as shown in Figure 11-7. 
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Figure 11-7 Mapping Specifications in the xmi file
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Appendix A caAdapter Example Data 
Example data are included in the caAdapter distribution. You can use the example data to 
become acquainted with the mapping tool or APIs before using your own data. Example 
data are located at the {home directory}\workingspace\examples 
directoryexamples directory (for example, 
C:\caadapter\workingspace\examples). The example data directory structure is 
shown in Figure A-1. 

 

Figure A.1 Example data directory structure 

The examples directory contains small (090102), medium (040002) and large 
(040001040011) sample HL7 v3 message files. The large HL7 v3 message example is an 
ICSR message. The other directories contain a subset of this data. For more information on 
mapping scenarios see the caAdapter Mapping Rules documentation. 

The Object-2-DB-Example directory contains ‘sample.map’, ‘sample.xmi’, 
‘sample_annotated.xmi’ files. 

The ‘SDTM_Mapping Examples’ directory contains ‘define.xml’, ‘Demographics.CSV’, 
‘Demographics.map’, ‘Demographics.scs ‘ and ‘SDTM_DM_Output.txt’ files. 

The V2V3 Mapping Examples directory contains ‘ADT_A03_to_402003’, ‘HL7.Messages’, 
‘version2.4’. The ‘version2.4’ contains ‘DataTypeSpec’, ‘DefinitionTable, ‘MessageStructure’ 
and ‘SegmentAttributeTable’. 
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Appendix B References 

Articles 
1. Java Programming: http://java.sun.com/learning/new2java/index.html 
2. Extensible Markup Language: http://www.w3.org/TR/REC-xml/ 
3. xml Metadata Interchange: http://www.omg.org/technology/documents/formal/xmi.htm 

 

caBIG Material 
1. caBIG: http://cabig.nci.nih.gov/ 
2. caBIG Compatibility Guidelines: http://cabig.nci.nih.gov/guidelines_documentation 

caCORE Material 
1. NCI CBIIT: http://ncicb.nci.nih.gov 

2. caCORE: http://ncicb.nci.nih.gov/core 

3. caBIO: http://ncicb.nci.nih.gov/core/caBIO 

4. caDSR: http://ncicb.nci.nih.gov/core/caDSR 

HL7 Concepts and Material 
1. HL7:   http://www.hl7.org/  
3. HL7 Tutorial: http://trials.nci.nih.gov/projects/infrastructureProject/caAdapter/HL7_Tutorial 

4. caAdapter: http://ncicb.nci.nih.gov/NCICB/infrastructure/cacore_overview/caadapter) 

5. HL7 Reference Information Model: https://www.hl7.org/library/data-
model/RIM/C30202/rim.htm 

6. HL7 Vocabulary Domains: http://www.hl7.org/library/data-
model/RIM/C30123/vocabulary.htm 

7. HL7 Version 3 Standard: http://www.hl7.org/v3ballot/html/welcome/environment/index.htm 
8. UCUM: http://aurora.regenstrief.org/UCUM/ucum.html 

Software Products 
1. Java: http://java.sun.com 

2. Ant: http://ant.apache.org/ 
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Study Data Tabulation Model (SDTM) Concepts and Material  
1. Java: http://www.cdisc.org/ 
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Glossary 
The following table contains a list of terms used in this document, with accompanying 
definitions. 

Term Definition 

CDMS Clinical Data Management System. 

CSV Comma Separated Value 

DMIM Domain Message Information Model. A subset of the RIM that 
includes RIM class clones, attributes, and associations that can be 
used to create messages for a particular domain (a particular area of 
interest in healthcare). 

EA Enterprise Architect. UML Modeling Tool.  

HL7 Health Level 7 (http://www.hl7.org/) is one of several American 
National Standards Institute (ANSI)-accredited Standards Developing 
Organizations (SDOs) operating in the healthcare arena. 

MIF Model Interchange Format. An xml representation of the information 
contained in an HL7 specification, and is the format that all HL7 v3 
specification authoring and manipulation tools will be expected to 
use. 

MT Message Type. The specification of an individual message in a 
specific implementation technology. 

OID HL7 v3 artifacts used to identify coding schemes and identifier 
namespaces. 

RIM Reference Information Model. The foundational Unified Modeling 
Language (UML) class diagram representing the universe of all 
healthcare data that may be exchanged between systems. 

RMIM Refined Message Information Model. A subset of a DMIM that is 
used to express the information content for an individual message or 
set of messages with annotations and refinements that are message 
specific. 

SDK caCORE Software Development Kit or caCORE SDK, a data 
management framework designed for researchers who need to be 
able to navigate through a large number of data sources. caCORE 
SDK is NCI CBIIT's platform for data management and semantic 
integration, built using formal techniques from the software 
engineering and computer science communities. 
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Term Definition 

SDTM Study Data Tabulation Model. A set of standards developed by the 
Clinical Data Interchange Standards Consortium (CDISC). 

UCUM Unified Code for Units of Measure 

UML Unified Modeling Language 

XML Extensible Markup Language 
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File 
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defined, 55 
dialog box, 57, 60 
Example file, 144 
format, 144 
overview, 56, 60 
tab features, 58 

HL7 v3 specification 
attribute properties panel, 49 
data type field properties panel, 49 
dialog box, 30 
element options, 30 
example file, 132 
format, 137 
tab overview, 28 
validating, 42 

I 
ICSR 

operational scenario, 15 
INFO message, 22 
inlineText data type field, 31 

J 
JdomMessageTypeLoader, 116 

L 
lib directory, 115, 116 
Link 

defined, 43 
properties panel, 48 

Log files, 119 
logging.properties file, 119 

M 
Mandatory 

values, 32 
Map specification 

business rules, 43 
creating, 45 
example file, 146, 148 
format, 145, 147 
internal reference, 130 
opening, 45 
status, 55 
tab overview, 44 
updating, 45 
validating, 54 

MapGenerateResult class, 117 
Mapping 

allowed symbol, 46 
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line, 46 
Mapping tool 

architecture, 7 
basic steps, 17 
defined, 5 
interface, 18 

Menu bar, 18 
Message builder, 6 
Message Level, 21 
Message parser, 6 
Message Service Integration, defined, 6 
Message types, supported, 31 
Messages, types of errors, 21 
Meta Data Loader, 6, 116 
MIF 
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file, 116 
format, 116 
HL7 file, 15 

Move Down button, 24 
Move Up button, 24 
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Multiples in HL7 v3 specification, 34 

N 
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training resources, 9 
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message, 14 
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Map specification, 55 
option, 20 

Reset button, 26 
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RMIM 
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S 
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Save file, 19 
Saving 

CSV Specification, 27 
HL7 v3 Message, 59, 61 
HL7 v3 Specification, 42 
map specification, 54 
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schema directory, 115 
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Segment 
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HL7 v3 specification, 28 
map specification, 44 
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types, 27 
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U 
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abstract data types, 38 
CSV specification, 24 
map specification, 45 
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Using 
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CSV specification, 26 
defined, 7 
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HL7 v3 specification, 42 
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W 
WARNING message, 22 

Windows distribution, starting, 11 
Windows layout, mapping tool, 18 
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